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Introduction
Microsoft Office 2007, the latest version of Microsoft’s comprehensive personal productivity applica-
tion software, contains a variety of improvements and enhancements over its previous versions. Even
users who have used and mastered the earlier versions of Microsoft Office and one or more of the
applications in its application suite might need introduction, training, review, and practice to master
the skills and knowledge required to become a Microsoft Certified Application Specialist (MCAS). 

It is also common that a user can be an expert in one or two of the Office applications and barely
know the others. For these two reasons, this book provides in-depth information and training in all
the applications covered in the MCAS exams:

. Using Microsoft Office Word 2007, Exam 77-601

. Using Microsoft Office Excel 2007, Exam 77-602

. Using Microsoft Office PowerPoint 2007, Exam 77-603

. Using Microsoft Office Outlook 2007, Exam 77-604

. Using Microsoft Office Access 2007, Exam 77-605

Before you delve into the five parts of this book that are designed to help you to prepare for and
successfully pass the MCAS exams, you should also have some knowledge of the Microsoft Business
Certifications program, its components, and what it takes to become certified. 

The Microsoft Business Certifications
Microsoft includes its certification programs for office workers, business managers, and teachers
under the umbrella of Microsoft Business Certifications (MBC). The three certification programs
under the MBC umbrella are the Microsoft Certified Application Specialist (MCAS), the legacy
Microsoft Office Specialist (MOS), and the Microsoft Certified Application Professional (MCAP).
This book focuses on the MCAS exams.

The Microsoft Certified Application Specialist (MCAS)
Certification
By earning MCAS credentials, you indicate to your employer or prospective employer that you
possess mastery, skills, and knowledge of one or more of the Microsoft Office applications. The
MCAS exams measure advanced knowledge, skills, and expertise within a standard set of objectives.
Employers know that an employee with MCAS credentials possesses the requisite capabilities to
perform at an advanced level with Microsoft Office applications.

The MCAS exams are all essentially at the specialist level in name, but the exams include expert-level
content as well. The MCAS exams cover Word 2007, Excel 2007, PowerPoint 2007, Access 2007,
Outlook 2007, and the Windows Vista operating system. When you pass any of the MCAS exams,
you earn an MCAS application specialist credential for that application or system. 
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Registering for the MCAS Exams
The MCAS testing program is conducted on two levels: the Microsoft Official Pre-Tests and the
MCAS application exams. The pretests are recommended to anyone preparing to take one or all of
the MCAS exams, but they are not required before taking an MCAS exam. 

To register and pay for either a Microsoft Official Pre-Test or an MCAS exam, and to find a
Microsoft Certified Exam Provider, visit the Certiport, Inc. website at www.certiport.com. At the
time of this writing, the cost of a Microsoft Official Pre-Test voucher is $26 per test, and the cost of
the MCAS exams are $89 each. 

If you are an active duty member or veteran, or a family member of an active duty member or veteran of the United
States Armed Forces (Army, Navy, Air Force, Marines, and Coast Guard), you might be eligible to receive reimburse-
ment for any of the Microsoft Business Certification exams, whether you pass or not, from the U.S. Department of
Veterans Affairs (VA) under the provisions of the Montgomery GI Bill, the Veterans Educational Assistance Program
(VEAP), and the Dependents’ Educational Assistance Program. Contact your local VA office or visit the following
website for more information: www.microsoft.com/learning/mcp/officespecialist/reimbursement.mspx.

NOTE

Depending on your confidence level of passing a particular application exam, you can also purchase a retake voucher
with the exam voucher for an additional $10. 

TIP

The MCAS exams are offered in a variety of languages, including Arabic, Chinese, German, Greek,
Italian, Japanese, Korean, Russian, and Spanish, and tests in other languages are being added contin-
ually. For a full list of the languages in which the MCAS exams are offered, visit the MCAS website
at www.microsoft.com/learning/mcp/msbc/localexams/.

Preparing to Take an MCAS Exam
Working through the step-by-step lessons and exercises in this book is a good first step in preparing
for an MCAS exam. This book covers all the exam objectives of each MCAS exam to ensure that you
have the opportunity to fully prepare for the exam. 

To enhance your comfort and confidence for any of the MCAS exams, MCAS Pre-Test exams are
available to identify the areas in which you might need more practice or knowledge to be successful
on the actual MCAS exam. Microsoft also provides a variety of instructor-led and online training
courses to help you prepare for the exams. For more information on the Microsoft courses, visit the
Microsoft Learning website at www.microsoft.com/learning/mcp/msbc/.

Taking the MCAS Exams
The exam format used in Microsoft exams varies from test to test, but the format used in the MCAS
exams is based on simulations, or what Microsoft refers to as performance-based or “live” exams. In
this type of test, you are required to enter data, identify the sequence of the steps used to complete a
task, or perform a sequence of steps or tasks to demonstrate your knowledge of how a particular
activity or event is carried out in the application being tested. For example, you might be called on to
create a table in Word 2007 and apply a prescribed series of formatting features to it, or you might

www.microsoft.com/learning/mcp/officespecialist/reimbursement.mspx
www.certiport.com
www.microsoft.com/learning/mcp/msbc/localexams/
www.microsoft.com/learning/mcp/msbc/
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be asked to apply conditional formatting to a table in an Excel 2007 worksheet or create mail folders
and apply categorization in Outlook 2007. You might be asked to choose the best answer in a
multiple-choice question about how a particular action is carried out. 

You are allowed 90 minutes to take each of the MCAS exams. At the end of your exam, your score is
immediately provided to you. If you fail the exam, you must wait seven days before reattempting it.
See “Getting Ready for the MCAS Exams” (before Chapter 1) for more information on preparing for
and taking the MCAS exams.

The Microsoft Office Specialist (MOS) Certification
The Microsoft Office Specialist (MOS) certification is the legacy certification program for Office
2000, Office XP, and Office 2003. The MOS certification program granted three certification levels:
Specialist, Expert, and Master. More information is available for the MOS certification tracks at
www.microsoft.com/learning/mcp/msbc/requirements/.

Microsoft Certified Application Professional (MCAP)
Certification
The Microsoft Certified Application Professional (MCAP) certification provides a credential that
verifies your skills and knowledge of the Microsoft Office 2007 application suite and its integration
into the Microsoft Office 2007 SharePoint Server (MOSS) system. The objective of the MCAP
exams is to measure your skills for working in interindustry and intercompany environments to
manage budgets and presentations, facilitate collaboration and cooperation among team members,
and to support the information needs of an organization. The MCAP exam requirements are not
covered in this book, which concentrates strictly on the MCAS exams. 

For more information on the MCAP certification, visit the following website:
www.microsoft.com/learning/mcp/msbc/mcap/default.mspx.

What’s in This Book?
The five MCAS exams (six, if you count the optional Windows Vista for the Business Worker 77-600
exam) each concentrate on a particular Microsoft Office 2007 application with a separate test for
Word 2007, Excel 2007, Office 2007, PowerPoint 2007, and Access 2007. Each of the five MCAS
exams is covered in a separate part of this book. 

To help you in your studies, each part of the book and that part’s chapters are aimed at one specific
application in the Microsoft Office 2007 suite. Each part covers all the MCAS exam objectives for a
particular application. As much as possible, the material in each part is sequenced to present it in the
context of a particular exam objective—how particular actions, commands, and features are
commonly used. However, some features, functions, or tools in the Microsoft Office 2007 suite do
stand on their own, but every attempt was made to keep it relevant and meaningful. 

The Organization of the Book
There are six parts to this book. The first part contains a single getting started chapter and the
remaining five parts cover the five MCAS applications over many chapters.

www.microsoft.com/learning/mcp/msbc/requirements/
www.microsoft.com/learning/mcp/msbc/mcap/default.mspx
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Each chapter begins with a list of the MCAS exam objectives covered in that chapter. These objectives
are indicated at each major section heading. See the “Exam Objectives Reference” following this
introduction for a complete list of the MCAS exam objectives and the pages to find coverage on each.

Aids to Help You Study and Prepare
In addition to the complete coverage of the exam objectives, each chapter contains several tips and
notes to provide you with additional information, shortcuts, or other ways to accomplish a particular
task. Each chapter also includes a Challenge designed to help you to practice the actions you might
be called on to perform during the exam. 

The key terms and review questions included at the end of each chapter are provided to help you to
understand and remember the context, application, meaning, and relationship of the terms, features,
and tools discussed in the chapter. 

The Companion CD
This book includes a companion CD so that you can further practice for the MCAS exams. The CD
includes the following:

. An electronic practice exam with 300 new questions—60 for each of the five MCAS exams

. An electronic copy of the book

. All the Office files referenced in the Challenge exercises in the book
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Collaborating and Securing Data

Objectives
This chapter helps you prepare for the MCAS: Using Microsoft Office Excel 2007, Exam 77-602, by
covering the following Microsoft objectives:

. Manage changes to workbooks. 

. Protect and share workbooks. 

. Prepare workbooks for distribution.

. Save workbooks.

. Set print options for printing data, worksheets, and workbooks. 
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Study Strategies 
This chapter covers the methods used to prepare, publish, and share Excel 2007 documents with other users on a local
or wide area network. Practical hands-on experience working with these Excel 2007 tools is vital to gaining an under-
standing of how they work and when to use them. To best prepare for the exam, you should make sure you know and
understand the use of the features, functions, and tools covered in this chapter. 

The best way to study for this section of the MCAS: Using Microsoft Office Excel 2007 exam is to perform the steps
involved in each part of these processes. To further prepare yourself for the scenarios contained on the exam, 
access the Excel 2007 Help resources to gain an understanding of exactly what each process does and why each
process is important. 
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Introduction
Although most Excel 2007 workbooks are created for personal use, sometimes you might want or
need to share a workbook with other users on a network. Sharing a workbook can be for purposes of
collaboration in which other users might need to have access to the workbook to enter or format
data. The sharing could also be just for sharing information in which you want to restrict the access
of other users to only certain parts of a workbook or merely to view its contents. 

The Collaborating and Securing Data section of the MCAS Using Microsoft Office Excel 2007 exam
covers the tools and functions available to protect and share a workbook for information or collabo-
ration purposes, which is the focus of this chapter. This chapter covers the functions and tools used
to allow users to edit portions of a workbook and to track any changes made to its contents, password
protect a worksheet or an entire workbook, and share a workbook, as well as the steps used to
prepare a workbook for distribution to a network. The tools and functions used to set the print
options for a workbook are also discussed. 

Managing Corrections and Additions Made 
to Workbooks
Objective:
Manage changes to workbooks. 

In situations where it is important to know what changes are made to a workbook and who made the
changes, you have the options to track the changes made to workshop data and to restrict access to
only certain parts of a workbook. The following two sections discuss each of these options. 

Tracking Changes to a Workbook
After a workbook has been completed and is ready for review by other collaborating users, it can be
important to know exactly what changes are made to it and by whom, especially on a more complex
workbook. This can be vital information in a collaborative environment. 

Tracking Changes in a Workbook
Excel 2007 provides the capability to track the changes made to a workbook. To engage this function,
follow these steps:

1. Select the Review tab of the Excel 2007 ribbon. 

2. In the Changes group, click the Track Changes button, and then click the Highlight
Changes option to display the Highlight Changes dialog box (see Figure 14.1).

When Track Changes is enabled for an Excel 2007 workbook, the workbook is automatically placed in a shared
status. When the Track Changes feature is disabled, the Change History worksheet is removed and the workbook is
no longer shared. 

NOTE
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3. On the Highlight Changes dialog box, make sure the check box associated with Track Changes
While Editing is checked. 

4. In the Highlight Which Changes section, use the check boxes to set the following options:

. When: When selected, this option tracks all changes or those made after a certain mile-
stone: Since I Last Saved, Not Yet Reviewed, or since a specified date. The Since Date
option defaults to the current date, but this can be replaced with a date you enter in the
When text box. 

. Who: When selected, this option tracks changes made by Everyone (meaning anyone),
Everyone But Me (meaning all other users), or only those changes made by a specific
person (the default is the current user). 

. Where: When selected, this option tracks changes made to a specific range of cells on a
specific worksheet. To set the range of cells in which you want to track changes, click
the worksheet button at the end of the Where text box to open the Highlight Changes
Range Selection dialog box and the current worksheet. Select another worksheet if
needed, select the cell range to be tracked, and click the Close button on the Highlight
Changes Range Selection dialog box to return to the Highlight Changes dialog box. If
this selection is not used, the default range for tracking changes is the entire active
worksheet. 

5. If you want to have the changed cells indicated on the display of a worksheet, check the check
box associated with Highlight Changes on Screen. The result of selecting this option is
shown in Figure 14.2. 

FIGURE 14.1 The Highlight Changes dialog box.

FIGURE 14.2 The cells that have been changed are highlighted
and tagged with a explanation of what change was made.
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6. To have the changes meeting the criteria entered into the Highlight Which Changes section
listed in a History worksheet in the workbook, check the check box associated with the List
Changes on a New Sheet option. If the List Changes on a New Sheet option is selected on
the Highlight Changes dialog box, a History worksheet is created in the same workbook.
Figure 14.3 shows the History worksheet relating to the changes shown in Figure 14.2. 

FIGURE 14.4 The Select Changes to Accept or Reject dialog box.

FIGURE 14.3 A History worksheet
added to an Excel 2007 workbook. 

The History worksheet doesn’t appear until the worksheet is saved with changes made. 

TIP

Managing Tracked Changes
After reviewing the changes made to a shared workbook, you have the options of taking no action
and leaving changes marked as changes, accepting a change to incorporate it into the document
permanently, or to reject a change and returning the affected cell to its original content. 

To accept or reject a tracked change, follow these steps:

1. Select the Review tab of the Excel 2007 ribbon. 

2. In the Changes group, click the Track Changes button, and then click the Accept/Reject
Changes option to display the Select Changes to Accept or Reject dialog box (see Figure 14.4). 

3. Like the Highlight Changes dialog box (refer to Figure 14.1), the Select Changes to Accept or
Reject dialog box has a set of check boxes that set the criteria for which changes are to be
accepted or rejected in its Which Changes section: 

. When: When selected, you have the option of selecting to accept or reject those
changes not yet reviewed or to enter a specific date to accept or delete any changes
made after that date. 

. Who: When selected, this option indicates that the changes made by Everyone
(meaning anyone), Everyone but Me (meaning all other users), or only those changes
made by a specific person (the default is the current user) are to be accepted or rejected. 

. Where: When selected, this option indicates that the changes made to a specific range
of cells are to be accepted or rejected. 
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4. Click the OK button on the Select Changes to Accept or Reject dialog box to display the
Accept or Reject Changes dialog box (see Figure 14.5). 

FIGURE 14.5 The Accept or Reject Changes dialog box.

FIGURE 14.6 The Allow Users to Edit Ranges dialog box.

5. The details of each change to the worksheet that met the selection criteria set on the Select
Changes to Accept or Reject dialog box are displayed one at a time in the text area of the
Accept or Reject Changes dialog box. 

6. For each of the changes displayed on the Accept or Reject Changes dialog box, you have the
option to Accept or Reject each change. You can also Accept All changes or Reject All changes.
To cancel accept or reject action, click the Close button.

7. After the last of the changes has been accepted or rejected, the dialog box closes. 

Allowing Users to Edit Selected Ranges
Before you share a workbook (see “Sharing a Workbook” later in the chapter) for other users, you
might want to restrict the range of cells other users can edit to one or more specific ranges on
selected worksheets. This allows you to prevent changes in content or format in all but the ranges in
which you have granted permission to other users to edit.

To allow other users to edit only one or more selected cell ranges in a worksheet, follow these steps:

Before you can allow users to edit selected cell ranges, you must disengage any share or tracked changes applied to
a workbook. 

1. On the Review tab of the Excel 2007 ribbon, click the Allow Users to Edit Ranges button in
the Changes group to display the Allow Users to Edit Ranges dialog box (see Figure 14.6). 

TIP
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2. To add a range of cells to the Ranges Unlocked by a Password When the Sheet Is Protected
list, click the New button, which displays the New Range dialog box (see Figure 14.7).

FIGURE 14.7 The New Range dialog box.

3. Enter a title for the range to be identified in the Title text box. 

4. In the Refers to Cells text box, enter the cell range you want to allow users to edit, or click the
worksheet button at the right end of the text box to return to the worksheet, where you can
select the cell range. 

5. If you want to enter a password that users will have to enter to access the cells indicated in the
Refers to Cells text box, enter it into the Range Password text box. To change the permissions
for what allowed users (those who know the password) are able to do to the allowed range, click
the Permissions button to open the Permissions for Range Title dialog box. 

6. Click the OK button. 

Protecting and Sharing an Excel 2007
Workbook
Objective:
Protect and share workbooks.

You are the lead member of a group charged with producing an important workbook for your organi-
zation. After creating the workbook and its worksheets and entering data gathered from a variety of
sources, you want to share the workbook in its draft form with the other members of the work group.
However, parts of the workbook came from verified or trusted sources and cannot or should not be
changed, except by the original author, so you also need to protect those parts of the workbook from
modifications. 

Excel 2007 provides you with the tools needed to carry out these tasks. Using the features of Excel
2007, you are able to share the workbook and protect all or part of its contents. In the sections that
follow, the procedures used to accomplish these two tasks are outlined. 

Protecting a Workbook and Its Worksheets
Protecting a workbook and all or some of its elements means that you assign a password to the entire
workbook, one or more of its worksheets, or to selected ranges of cells in worksheets. As discussed
earlier in the chapter in the section “Allowing Users to Edit Selected Ranges,” selected ranges of
cells can be protected and accessed only through a password. This type of protection can be applied
to the entire workbook as well. 
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When protection is applied to a workbook, it can be applied on two levels of workbook elements:
Windows or Structure. The Windows level of workbook elements provides protection against users
resizing, moving, or closing a worksheet in the workbook. The Structure level of workbook elements
provides protection against the following actions:

. Inserting a new worksheet or chart sheet

. Copying or moving a worksheet to a new workbook

. Changing the name of a worksheet

. Recording a macro

. Viewing hidden worksheets

Protecting a Workbook
To protect all or certain elements of an Excel 2007 workbook, follow these steps:

1. With the workbook to be protected open in Excel 2007, select the Review tab and click the
Protect Workbook button in the Changes section to display the Protect Structure and
Windows dialog box (see Figure 14.8). 

FIGURE 14.8 The Protect Structure and Windows dialog box.

2. Click the check box associated with the level(s) of protection you want to apply to the work-
book, choosing either Structure or Windows, or both. The Structure option prevents users
from reordering the worksheets in a workbook, including preventing them from adding new
worksheets or deleting existing worksheets. The Windows option prevents users from resizing
or moving the Excel workspace window. 

3. Enter a password that users must enter to access the workbook if desired. The password is
optional, but it can add to protection of the workbook. 

4. Click the OK button to save the protection settings. 

5. If you entered a password in step 3, you are asked to confirm the password in the Confirm
Password dialog box. 

Protecting a Wordbook at the File Level
To protect a workbook at the filename level, you can assign a password to the file that effectively
overrides any of the internally configured security of a workbook. To set a password on a workbook
file, follow these steps:

1. Click the Microsoft Office Button and click the Save As option to display the Save As 
dialog box. 
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2. Set the filename, location, and file format type, and then click the Tools button in the lower-
left corner of the dialog box. 

3. From the Tools menu, click General Options to display the General Options dialog box (see
Figure 14.9). 

4. If you want to create a backup of the workbook file each time it is opened, check the check box
associated with Always Create Backup. This option is separate from assigning a password and
can be set even when a password isn’t assigned to the file.

5. In the File Sharing section, you can assign a password to control either the opening of a file or
the modification of a file. For an Excel 2007 workbook on which workbook protection has been
activated, the Password to Open option is unavailable (because it’s not needed), but you can
enter a password in the Password to Modify option. 

FIGURE 14.9 The General Options dialog box.

If the workbook has already been shared, the password already assigned to the workbook cannot be changed; there-
fore, this password will not take effect. 

NOTE

6. If you want users to open the workbook in read-only status, check the Read-only
Recommended check box. 

7. Click the OK button to save the General Options settings for the workbook and return to the
Save As dialog box. 

Protecting a Worksheet
Protecting an Excel 2007 worksheet actually means protecting or locking the worksheet elements you
don’t want to allow other users to change. The elements of a worksheet are the cells, columns, rows,
hyperlinks, illustrations, and other objects. 

To protect an Excel 2007 worksheet and its elements, use the following steps:

1. Select the worksheet you want to protect. 

2. Unlock any cells or ranges of cells on the worksheet using these steps:

1. Select the cells or ranges of cells to be unlocked. If you’re in doubt exactly which cells
are locked, select the entire worksheet or the cells containing data. 

2. Select the Home tab of the Excel 2007 ribbon and click the Format button in the Cells
group to display its menu. 
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3. From the Format menu, click the Format Cells option to display the Custom Lists
dialog box. 

4. Select the Protection tab and remove the check mark in the Locked check box, if any,
and click the OK button. 

3. If you want to hide any of the formulas in the worksheet, select all the cell ranges containing
the formulas you want to hide. Then use these steps to hide the formulas:

1. Select the Home tab and click the Format button in the Cells group to display its menu. 

2. From the Format menu, click the Format Cells option to display the Custom Lists
dialog box. 

3. Select the Protection tab and check the Hidden check box, if it is not already checked,
and then click the OK button to hide the formulas in the cell ranges selected.

4. If you want to include protection for the illustrations, charts, or other objects inserted into the
worksheet, use the following steps:

1. Select the Home tab and click the Find & Select button in the Editing group to display
its menu. 

2. From the Find & Select menu, click the Go To Special option to display the Go To
Special dialog box.

3. On the Go To Special dialog box, select the Objects option and click the OK button to
select all of the objects in the worksheet. 

4. On the Picture Tools Format tab, click the Dialog Box button on the Size group title
bar to display the Size and Properties dialog box (see Figure 14.10). 

FIGURE 14.10 The Properties tab of the Size and Properties dialog box.

5. Click the Properties tab and remove the check mark in the Locked check box. 

5. Click the Review tab, and click the Protect Sheet button in the Changes group to display the
Protect Sheet dialog box (see Figure 14.11). 
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6. Enter the password you want to use to protect the worksheet and its elements in the Password
to Unprotect Sheet text box.

7. In the Allow All Users of This Worksheet To text area, check the elements and actions you
want to allow all users to perform. If an element or action is not checked, a user must enter the
password to access the element or perform the action.

FIGURE 14.11 The Protect Sheet dialog box.

To select more than one cell range, select the first range and then hold down the Ctrl key while selecting any subse-
quent range. 

TIP

You should make all necessary protection and sharing settings changes and test them before you actually share the
document. Inadvertent changes made innocently by shared users could render the document inaccurate or useless. 

NOTE

Sharing a Workbook or Worksheet
When you work in a collaborative environment, it is common to share an Excel 2007 workbook or
one or more of its worksheets so that other users can collaborate or review its content. The steps
used to share a workbook or a worksheet are similar, but some subtle differences exist, as explained in
the following two sections. 

Sharing a Workbook
Follow these steps to share an Excel 2007 workbook:

1. Open the workbook to be shared.

2. Select the Review tab and click the Share Workbook button in the Changes section to display
the Share Workbook dialog box (see Figure 14.12). 
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3. Select the Editing tab. Depending on the dispersion or size of the collaborative group, you
might or might not want to allow for multiple users to make changes to the workbook at the
same time. If you do, check the check box associated with Allow Changes by More Than
One User at the Same Time. This Also Allows Workbook Merging. Selecting this option
enables the options on the Advanced tab. 

4. Select the Advanced tab and set the options you want to use to control the changes made to
the workbook. The options that can be set are the following:

. Track Changes: If you want to save the change history of the workbook, set the
number of days you want to keep (30 is the default value) in the box associated with
Keep History for nn Days or choose the option Don’t Keep Change History.

. Update Changes: If you want to save all changes when the workbook is saved, select
the option for When File Is Saved; to be selective of which changes are saved, set the
minute value of the Automatically Save option, and then choose between Save My
Changes and See Others’ Changes and Just See Other Users’ Changes.

. Conflicting Changes Between Users: When two changes to a single cell or range of
cells are in conflict, one must win. Choose between Ask Me Which Changes Win and
The Changes Being Saved Win. 

. Include in Personal View: Check the check box associated with Print settings and
Filter settings if you want to share these settings with other users. 

5. Click the OK button to share the workbook. 

Some features and formats cannot be added to a workbook after it has been shared. These features
and formats are the following:

. Charts

. Conditional formatting

. Data validation

. Hyperlinks

FIGURE 14.12 The Share Workbook dialog box.
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. Macros

. Merged cells

. Outlines

. Pictures

. Protection

. Subtotals

. Tables

These features and formats cannot be inserted or modified in a shared workbook. If you want to
include them in the workbook you must insert, apply, or modify them before you share the workbook. 

Controlling Access and Changes to a Shared Workbook
While a workbook is shared, you can both control who can access the workbook and resolve change
conflicts. These two actions are explained in the following sections.

Removing a Shared User

If you want to remove a user from sharing a workbook for any reason during a collaborative session,
follow these steps:

1. Open the shared workbook. 

2. Select the Review tab and click the Share Workbook button in the Changes group to display
the Share Workbook dialog box, shown earlier in Figure 14.12. 

3. In the Who Has This Workbook Open Now list, select the user to be removed and click the
Remove User button. 

This procedure breaks the current link of the user to the workbook, but it doesn’t prevent the user
from accessing and editing the workbook at a later time. 

Resolving Change Conflicts

When you and at least one other user are editing a shared workbook at the same time, there are
often changes made to the same cell simultaneously. In these situations, the owner (the user who
shared the workbook) controls which changes are kept. When the workbook is saved with conflicting
changes by other users, the Resolve Conflicts dialog box is displayed. On the Resolve Conflicts
dialog box, you can review the conflicting changes and choose either Accept Mine or Accept Other
to resolve the conflict. 

Stop Sharing a Workbook

When you no longer want to share a workbook, you can remove the sharing status of the workbook
using the following steps:

1. Open the shared workbook.

2. Select the Review tab and click the Track Changes button in the Changes group to display 
its menu. 
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3. Click the Highlight Changes option to display the Highlight Changes dialog box (shown
earlier in the chapter in Figure 14.1). 

4. For the When option, select All from the pull-down list. 

5. Clear the check boxes associated with Who and Where.

6. Check the check box associated with List Changes on a New Sheet to create a History work-
sheet for the changes made to the shared workbook. 

7. Click the OK button to remove the share on the workbook. 

Preparing a Workbook for Distribution
Objective:
Prepare workbooks for distribution. 

Microsoft Office 2007 provides a common set of tools and features to help you prepare a document
for distribution, regardless of the application in which the document was created, including Excel
2007. As outlined in Chapter 9, “Sharing and Securing Content,” you can use a series of steps 
to ensure that a document published or distributed to network users is protected and that no 
personal information is released. Perform the following steps to prepare an Excel 2007 workbook 
for distribution: 

1. Edit workbook properties.

2. Inspect the workbook document.

3. Encrypt the workbook document.

4. Add an optional digital signature.

5. Run a compatibility check.

6. Mark the workbook document as final.

For the details on each of the preceding actions, see Chapter 9, remembering that you are working
with an Excel 2007 workbook instead of a Word 2007 document.

After you have marked an Excel workbook as final, you’ll likely want to publish (distribute) the work-
book for other users to use, see, or reference. The Publish and Send selections on the Microsoft
Office Button enable you to send the finalized document as an email attachment (as an Excel docu-
ment, a PDF file, or an XPS file) or publish the document to an Excel Services or SharePoint library,
or to a created document workspace.

Saving a Workbook
Objective:
Save workbooks. 

In addition to the capability of saving an Excel 2007 workbook as an Excel 2007 workbook (with an
.xlsx extension), you can use several other file format options to save a workbook. The Save option
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on the Microsoft Office Button menu is used to save a workbook using the same filename and loca-
tion used in previous save actions. The one exception is the first time the document is saved, the Save
option invokes the Save As option. 

The Save As option on the Microsoft Office Button menu is used to save a workbook to a different
location, change the filename, or change the file format in which the workbook is saved. 

Saving a Workbook with the Same Filename and Location
To save an Excel 2007 workbook using the same filename, location, and file format, follow these steps:

1. Click the Microsoft Office Button.

2. Click the Save option. 

3. Unless the Check Compatibility When Workbook Is Saved option was selected when the
Compatibility Inspector was used on the workbook, the file is saved without any other interven-
tions; otherwise, the results of the Compatibility Inspector are displayed.

For more information on the Microsoft Office Compatibility Inspector, see Chapter 9, “Sharing and Securing Content.” 

NOTE

Saving a Workbook with a Different Name, Location, 
or Format
Use the Save As option of the Microsoft Office Button when you want to change the workbook’s
name, location, or file format. To save a workbook changing any of these characteristics, use the
following steps:

1. Click the Microsoft Office Button. 

2. Move the mouse pointer over the Save As option to display the Save As menu (see Figure 14.13). 

FIGURE 14.13 The Save As menu of the Microsoft Office Button.
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3. Use the Excel Workbook option of the Save As menu to save the document as an Excel 2007
workbook. Clicking this option displays the Save As dialog box (see Figure 14.14), on which
you can navigate to a new file location, change the filename, and if desired select a new file
format from the Save as Type pull-down list. The following file formats are available on the
Save as type pull-down list:

FIGURE 14.14 The Save As dialog box.

. The Excel Workbook option saves the workbook in its default file format, which is the
Office Open XML file format and the primary reason Office 2007 document files aren’t
backward compatible to previous versions of Office or its applications. This file format is
indicated with the .xlsx file extension. 

. The Excel Macro-Enabled Workbook option saves the workbook in an Extensible
Markup Language (XML) format and retains any macros embedded in the workbook.
This file format is indicated with the .xlsm file extension. 

. The Excel Binary Workbook option saves the workbook in an XML style file format but
converts the contents of the workbook into binary strings. This file format is indicated
with the .xlsb file extension. 

. The Excel 97-2003 Workbook option saves the workbook in compatibility mode using a
file format compatible with earlier versions of Excel. This file format is indicated with
the .xls file extension. Some features of Excel 2007 are not backward compatible, and a
message box might warn you of this fact. 

. The XML Data option saves the workbook in an XML file format, providing the 
workbook has had XML mappings applied to it, which is a fairly extensive process but
one you don’t need to worry about for the exam. This file type is saved with the .xml
file extension.

. The Single File Web Page option saves the workbook as a Multipurpose Internet Mail
Extensions (MIME) encapsulated file coded as Hypertext Markup Language (HTML).
This file format captures the entire workbook into a single .mht or .mhtml file that can
be sent by email. Figure 14.15 shows the source code of an Excel workbook saved using
the Single File Web Page option. 
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4. After entering the filename, selecting Save as Type, and navigating to the location in which
you want to place the workbook, click the Save button to save the workbook. 

Setting Print Options
Objective:
Set print options for printing data, worksheets, and workbooks.

Excel 2007 supports printing for partial worksheets, entire worksheets, and entire workbooks
(meaning all the worksheets). Each of these processes uses essentially the same actions, with one or
two options differentiating what is printed. 

Changing Active Printer
On the Print dialog box that displays when the Microsoft Office Button’s Print option is selected,
you can choose to change the active printer from the default printer to any other printer to which
you have permission and access to use. Follow these steps to change the active printer:

To demonstrate a comparison of at least one aspect of the different file formats that can be used to save an Excel
workbook, Figure 14.16 illustrates the same Excel workbook saved to five of the available file formats. Notice the
differences in the sizes of the saved files. 

NOTE

FIGURE 14.15 The source code for
an Excel 2007 worksheet saved using
the Single File Web Page option. 

FIGURE 14.16 A comparison of the file sizes
resulting from saving the same Excel workbook in
different file formats. 



Setting Print Options
433

1. Click the Microsoft Office Button to display its menu. 

2. Move the mouse pointer over the Print option to display the Print menu. 

3. Click the Print option to display the Print dialog box (see Figure 14.17). 

FIGURE 14.17 The Print dialog box.

4. In the Printer section, use the Name pull-down list to select the printer on which you want to
print. If the printer you want to use is not listed on the Name pull-down list, click the Find Printer
button to locate the printer (Directory Services must be active for this function to be used). 

5. Click the Properties button to set the print options for the printer, which vary by type of printer. 

Printing a Partial Worksheet
If you want to print only a selected range of cells from an Excel 2007 worksheet, you can use two
options. The first option is to print a range of selected cells and the second is to set a print area 
in a worksheet. 

Printing a Range of Selected Cells
To print a range of selected cells from a worksheet in an Excel 2007 workbook, follow these steps:

1. Select the range of cells you want to print.

2. Click the Microsoft Office Button and move your mouse pointer over the Print option to
display the Print menu. 

3. Click the Print option to display the Print dialog box (refer to Figure 4.17). In the Printer
section, choose the printer you want to use. 

4. In the Print What section, select the Selection option. 

5. Click OK to print the selected range on the selected printer. 

Setting a Print Area in a Worksheet
If you want to designate a range of cells as the default selected range of cells that are the only cells
printed anytime the worksheet is printed, follow these steps: 
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1. Select the range of cells to be designated as a print area. 

2. Select the Page Layout tab of the Excel 2007 ribbon. 

3. Click the Print Area button in the Page Setup group to display its menu. 

4. Click the Set Print Area option to set the selected range of cells as the print area. 

5. To add one or more selected ranges of cells to the print area, select each range of cells and open
the Print Area menu from the Page Setup group. Click the Add to Print Area option to add
the selected cells to the print area. 

6. To print the print area of a worksheet, select the Active Sheet(s) option in the Print What
section of the Print dialog box. 

Printing a Worksheet
To print the entire contents of a selected worksheet from an Excel 2007 workbook, follow these steps:

1. Select the worksheet you want to print.

2. Click the Print option from the Microsoft Office Button to display the Print dialog box. 

3. In the Printer section, choose the printer you wish to use. 

4. In the Print What section, select the Active Sheet(s) option. If you want to print all the
content on the worksheet, including the content not in a print area, check the Ignore Print
Areas option. 

5. Click OK to print the worksheet on the selected printer. 

If you want to print more two or more worksheets from the same workbook, before selecting the Print
option, hold down the Ctrl key and click the worksheet tabs of the worksheets you want to print. 

Printing a Workbook
If you want to print all the content in all the worksheets of an Excel 2007 workbook, follow 
these steps:

1. With the workbook to be printed open in the Excel 2007 workspace, click the Print option
from the Microsoft Office Button to display the Print dialog box. 

2. In the Printer section, choose the printer you want to use. 

3. In the Print What section, select the Entire Workbook option. If you want to print all the
content of the workbook, including that not designated as part of a print area, click the Ignore
Print Areas check box.

4. Click OK to print the workbook on the selected printer. 

Printing Comments by Reviewers
After an Excel 2007 workbook has been reviewed by other users, you might want to print any
comments reviewers have inserted into the document. Excel 2007 allows you to print any reviewers’
comments just as they appear on each worksheet. 
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Follow these steps to print comments inserted into an Excel 2007 worksheet:

1. Display the worksheet containing the comments you want to print by clicking its tab. 

2. To display one or all of the comments in place, use these steps:

. To display the comments of a single cell, click in the cell, select the Review tab, and
then click the Show/Hide Comment button in the Comments group.

. To display all the comments on a worksheet, click the Show All Comments option in
the Comments group on the Review tab. 

3. Select the Page Layout tab and click the dialog box launcher button of the Page Setup group
to display the Page Setup dialog box. 

4. Select the Sheet tab on the Page Setup dialog box and use the Comments pull-down list to set
how you want the comments to print, choosing between As Displayed on Sheet (in place) or
At End of Sheet (as a list).

5. Click the OK button to save the Page Setup settings. 

6. Click the Microsoft Office Button and click the Print option to display the Print dialog box.
Click OK to print the worksheet and comments. 

Challenge
In this exercise, you apply the functions and tools used to track changes made to a workbook, save the workbook,
and protect and share an Excel 2007 workbook with other users on a network. 

1. Open any workbook from the Practice Files folder on the CD accompanying this book or one of your own.
Select a worksheet to use in this challenge project. 

2. Enable the Track Changes function so that all changes made by anyone to any part of the workbook are high-
lighted on the display. 

3. Randomly make changes to at least 10 cells in the worksheet, and then change the name of the worksheet.
After changing the worksheet name, make another set of random changes to the worksheet. 

4. Save the workbook using the filename Ch14_Challenge.xlsx.

5. Change the Track Changes function to display all changes made to the document and to list the changes in a
History worksheet. 

6. Select the History worksheet and filter the changes to show only those performed before the worksheet name
was changed. 

7. Print the filtered History worksheet. 

8. Accept all changes made to the worksheet. 

9. Answer these questions:

. What happens to the History worksheet when you accept all changes?

. What procedure should you use if you want to accept the change made to only one cell and reject 
all others?
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Chapter Summary
This chapter covered the features of Excel 2007 that are used to protect the integrity of a workbook
or worksheet. In this chapter, you have learned the steps used to manage changes to a workbook, how
to protect a workbook or worksheet, the steps used to share a workbook, and how to prepare a work-
book for distribution to a network. In addition, you learned the process and options available when
saving a workbook, including the various file formats available, and the options you can use when
printing a selected range of cells, a worksheet, or an entire workbook. 

This chapter provided you with basic, intermediate, and a few advanced techniques that you can use
to protect a shared or distributed workbook, to save a workbook using a variety of file formats,
control any changes made to its worksheets, and print its content. 

Key Terms
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. Accept/Reject Changes

. Allow Users to Edit Ranges

. Changes group

. Excel Binary Workbook
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Review Questions
Choose the best answer to each question. The answers appear in the section following the questions.

1. To track only certain changes made to an Excel workbook, which of the following parame-
ters can be used? (Choose all that apply.)

(A) Who

(B) When

(C) Why

(D) Where

2. When a worksheet has been protected, an entry to what list can permit users to edit a
certain range of cells using a different password?

(A) Who

(B) Permissions

(C) Ranges Unlocked by a Password When the Sheet Is Protected

(D) Allow All Users of This Worksheet To

3. The Protection option that prevents a user from adding a new worksheet to a protected
workbook is

(A) Password

(B) Structure

(C) Windows

(D) Custom Lists

4. The option that allows users of a protected worksheet to select locked cells is found in
what list?

(A) Custom Lists

(B) Allow All Users of This Worksheet To

(C) Protect Worksheet and Contents of Locked Cells

(D) Password to Modify

5. On which tab and group (tab, group) of the Excel 2007 ribbon is the Share Workbook
function located?

(A) Review, Proofing

(B) Data, Connections

(C) View, Window

(D) Review, Changes
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6. Which one of the following features or formatting options can be performed on a shared
workbook?

(A) Charts

(B) Macros

(C) Cell formatting

(D) Tables

7. What primary element is used to protect a workbook at the file level?

(A) Password

(B) Permissions

(C) Custom Lists

(D) Protect Worksheet and Contents of Locked Cells

8. Which of the file formats available in Excel 2007 saves a workbook file in an XML frame-
work? (Choose all that apply.)

(A) Excel Workbook

(B) Excel Macro-Enabled Workbook 

(C) Excel Binary Workbook

(D) Single File Web Page

9. What print option should be used to print a selected range of cells from a worksheet in an
Excel 2007 workbook that has not been designated as a print area?

(A) Active Sheet

(B) Entire Workbook

(C) Table 

(D) Selection

10. If you want to print all the data in an Excel 2007 workbook, you would choose the Entire
Workbook option in the Print What section of the Print dialog box, along with what other
setting?

(A) Collate

(B) Pages (to specify all of the pages in the workbook)

(C) Ignore Print Areas

(D) Selection
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Answers to Review Questions
1. The best answers are A, B, and D. The Track Changes dialog box enables you to set criteria

including who makes the changes, when the changes were made, and in which part of the work-
book the changes were made to determine which changes are tracked. Because no Why option
is available, answer C is incorrect. 

2. The best answer is D. Although a worksheet is protected, there might be changes you want to
allow users to perform. These types of changes you want to allow are indicated in the Allow All
Users of the Workbook To section of the Protect Sheet dialog box. The Who setting is a part
of the Track Changes function, so answer A is incorrect. Both the Permissions option and the
Ranges Unlocked by a Password When the Sheet Is Protected are associated with the Allow
Users to Edit Ranges function, which requires a password, so Answers B and C are incorrect.

3. The best answer is B. The structure level option prevents users from changing the structure
of the worksheets in a protected workbook, including changing the order of the worksheets and
adding or deleting worksheets. The use of a password allows users only to gain access to a
workbook, so answer A is incorrect. The Windows level option prevents users only from
moving or resizing Excel 2007 windows, so Answer C is incorrect. Custom lists are used prima-
rily with sorts and filters, so Answer D is incorrect. 

4. The best answer is B. On the Protect Sheet dialog box, you can indicate which functions or
formatting you want to allow users to perform on a protected worksheet in the Allow All Users
of This Worksheet To area. Custom lists are primarily associated with sorts and filters, so
Answer A is incorrect. Protect Worksheet and Contents of Locked Cells is a setting option on
the Protect Sheet dialog box that acts like an umbrella protecting anything that is not exempted
in the Allow All Users of the Worksheet To area, so Answer C is incorrect. The Password to
Modify setting is an option on the Save As General Options, so Answer D is incorrect. 

5. The best answer is D. The Share Workbook function is located on the Review tab in the
Changes group and is used to share a workbook with other users on a network. The Proofing
group of the Review tab includes features like the Spelling Checker and Research, so Answer A
is incorrect. The Connections group on the Data tab is used to establish links between files and
external data sources, so Answer B is incorrect. The Window group of the View tab controls
the visual makeup and structure of the active window, so Answer C is incorrect. 

6. The best answer is C. Unless specifically otherwise allowed, only basic cell formatting can be
performed on a shared workbook. Charts, macros, and tables cannot be added to or modified in
a shared workbook, so Answers A, B, and D are incorrect. 

7. The best answer is A. Yes, beware the obvious answers, because sometimes they are correct. At
the file level, a password is the primary protection element. File permissions restrict the action
that can be taken by a user on an open file, so Answer B is incorrect. Custom lists are primarily
used with sorts and filters, so Answer C is incorrect. The Protect Worksheet feature doesn’t
protect the entire workbook and especially not at the file level, so Answer D is incorrect. 

8. The best answers are A, B, and C. The default file format for an Excel 2007 worksheet is the
Office Open XML format. The Macro-Enabled Workbook format and the Binary Workbook
format both use an XML format as well. The Single File Web Page format uses a MIME-
encapsulated HTML format, so Answer D is incorrect. 
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9. The best answer is D. The Selection option prints only whatever cells are selected in an Excel
2007 worksheet. The Active Sheet option prints the entirety of currently selected worksheet(s),
but if print areas are designated, the data printed is limited to the print areas, so Answer A is
incorrect. The Entire Workbook option prints, as its name suggests, the entirety of the active
workbook but, if print areas are designated, the data printed is limited to the print areas, so
Answer B is incorrect. If a worksheet contains a table, the Table option prints only the table
selected, so Answer C is incorrect. 

10. The best answer is C. Unless the print area boundaries are ignored, only the print areas are
printed on the Active Sheet or Entire Workbook selections. Activating the Ignore Print Areas
option allows all the data in the workbook to print. Collate is a printer command that instructs
the printer that when printing multiple copies of a workbook to print the pages as a set, so
Answer A is incorrect. The Pages option sets a range of page numbers you want to print, so
Answer B is incorrect. The Selection option prints only a range of cells currently selected, so
Answer D is incorrect.
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array formulas, calculating results via, 357

art
clip art

adding to email, 568
adding to Excel charts, 396
adding to object boxes (PowerPoint presentations),

460
adding to Word documents, 91-93
slide master backgrounds (PowerPoint presenta-

tions), 468
SmartArt graphics

all option, 95
creating, 95
email, adding to, 568
Excel charts, adding to, 397
object boxes (PowerPoint presentations), adding to,

458
Word documents, inserting into, 91, 95-96

Ask rule (Word Rules menu), 201

attachments
email

business cards as, 571
files as, 570
graphics as, 568-569
Outlook items as, 570
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Word documents, attaching to database tables, 679-680
editing attached files, 681
removing attached files, 682
saving attached files, 682

AutoArchive feature (Outlook 2007), 629-632

AutoFill feature (data entry), 267-269, 272

AutoFilter function (Excel 2007), filtering cell data, 405-406

AutoFit feature (worksheets), 314

automated email messages
AutoReply, 576-578
Out of Office Assistant, 574-576

Automatic Formatting button (Custom View: Documents
dialog), 547

AutoNumber data types, 661, 698

AutoNumber primary keys (database tables), 672

AutoReply (Outlook 2007)
message templates, 576
rules

creating, 576-577
turning off, 578

autoshapes, inserting into Word documents, 97

AVERAGEIF function, 354, 361

AVERAGEIFS function, 354

Axes group (Chart Tools Layout tab), 393

B
backgrounds

Background group (Chart Tools Layout tab), 393
databases, 749, 761
email, changing in, 564-567
slide masters (PowerPoint presentations), setting for,

467-469
worksheets, changing in, 303-304

Banded Columns option (Table Tools Design tab), 165

Banded Rows option (Table Tools Design tab), 164

bar charts (Excel 2007), 386

bevel effects, adding to images in Word documents, 109

bibliographies, Word documents, 191

Blank and Recent option (New Document dialog, Templates
section), 31

blank documents, opening, 30

Blank slide layout (PowerPoint 2007), 450

blinds transitions. See Stripes and Bars option (PowerPoint
transitions)

Book Fold option (documents), 50

bookmarks
Set Bookmark rule (Word Rules menu), 201
Word tables, inserting into, 171

borders
cells (worksheets), adding to, 315-316
Excel charts, changing, 395
images in Word documents, 76

adding to, 107-108
applying to tables, 166
highlighting text via borders, 118-119

Brightness icon (Word Picture Tools Format ribbon), 102

bring to front option (PowerPoint slides), 462

bubble charts (Excel 2007), 388

building blocks (Word 2007)
changing, 136
creating, 133-134
removing, 137
renaming, 136
saving in templates, 135
Word documents, inserting into, 134

bulleted lists
creating, 137-138
email, adding to, 559
formatting, 140-141, 145
sorting, 146

business cards
Business Card view, 548, 593
email, attaching to, 571

buttons, aligning in Word tables, 168

buying pretest vouchers, 7

By Category view (Contacts folder), 594

By Company view (Contacts folder), 595

By Location view (Contacts folder), 595

C
Calendar (Outlook 2007)

email, sending via, 613
saving as iCalendar, 612
sharing, 613-614

Caption property (Access Design view), 664

captions
images in Word documents, 114-115
slides (PowerPoint 2007), 450

Card view (Create a New View dialog), 548

categorizing contacts (Outlook 2007), 598-599

CD, packaging PowerPoint presentations on, 530-532

Cell Size group (Table Tools Layout tab), 168

cells
Word tables

aligning margins in, 168

attachments
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cell references, 170
merging in, 167
splitting in, 168

workbooks, locking in, 276-277
worksheets

adding borders, 315-316
adding color, 324
adding data bars, 368
adding gradient color scales to cell ranges, 369
adding icons to cells, 369
aligning data, 317-318, 321-322
applying styles, 316-317
Cell Styles gallery, 317
changing fonts, 308-310
changing orientation (rotation), 320
converting tables to, 334
defined names, 328-332
deleting, 312-313
editing cell ranges, 421-422
filtering data in, 405-407
fitting data to cell size, 323-324
formatting text via formulas, 365-369
grouping data in outlines, 399
hiding data, 325
highlighting, 366-368
indenting data, 318
inserting cells, 310-311
inserting subtotals into cell ranges, 355
inserting subtotals into outlines, 400-401
merging cells, 324-325
name scope, 330
printing selected cell ranges, 433
sorting data, 403-404
table names, 328
wrapping data, 319

centering
aligned cell data (worksheets), 318
text, Center Across Selection option (Excel Format

Cells dialog, Alignment tab), 321
Change Picture icon (Word Picture Tools Format ribbon),

105

character styles (Word 2007), 70

charts (Excel 2007), 384
area charts, 386
bar charts, 386
bubble charts, 388
Chart Style group (Chart Tools Design tab), 394
Chart Tools dialog

Design tab, 391, 394

Format tab, 392-395, 398-399
Layout tab, 392-393

column charts, 385
creating, 99-100, 389-390
customizing, 394

changing border styles, 395
changing chart color, 395
changing chart layouts, 394
changing chart shape, 395
changing chart styles, 394
changing fill color, 396
changing text styles, 396

doughnut charts, 388
email, adding to, 568
formatting, 391-393
illustrations

adding, 396-397
customizing, 398-399

line charts, 385
moving, 395
object boxes (PowerPoint presentations), adding to,

457-458
pie charts, 385
radar charts, 389
scatter (XY) charts, 387
stock charts, 387
surface charts, 387
Word documents, inserting into, 91, 99-100

Clear Rules option (Conditional Formatting dialog), 372

clearing (emptying) Clipboard, 44

clip art
email, adding to, 568
Excel charts, adding to, 396
object boxes (PowerPoint presentations), adding to,

460
slide master backgrounds (PowerPoint presentations),

468
Word documents, inserting into, 91-93

Clipboard, 44

Close Header and Footer button (Header and Footer Tools
Design tab), 47

Close link (Microsoft Office Button), 15, 21

closing documents, 21

collapsing/expanding outlines (Excel 2007), 402

color
Color Scales option (Conditional Formatting dialog),

369
color schemes (skins), changing in Word 2007, 59
document backgrounds (Word 2007), 76
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email
backgrounds, 565
categorizing via color, 622

Excel charts, changing in, 395-396
gradient scales adding to Excel cell ranges, 369
recoloring images, Word documents, 101-103
slide master backgrounds (PowerPoint presentations),

468
worksheets

adding color to cells, 324
changing background color, 303-304
changing gridline color, 324
changing tab color, 301

column charts (Excel 2007), 385

columns
Format Columns button (Custom View: Documents

dialog), 547
Word tables

inserting/deleting from, 167
sizing in, 168

worksheets
changing width, 313-314
deleting, 312-313
hiding, 326
inserting into, 311-312

comments
Excel 2007 documents, 434-435
presentation slides, 506

deleting comments from, 508-509
editing comments on, 508
inserting comments on, 507
reviewing comments, 507

Word documents
editing in, 228
inserting into, 227-228
removing from, 230-231
reviewing in, 229-230

Comments and Annotations category (Document Inspector),
510

Compact and Repair Database tool (Access 2007), 758-761

comparing Word documents, 220-222

Comparison slide layout (PowerPoint 2007), 450

compatibility
Access 2007 database conversions, 757-758
Compatibility Checker, 512-513
Word documents, checking in, 253

Compress Pictures icon (Word Picture Tools Format ribbon),
104-105

compression (files), image files in Word documents, 
104-105

Conditional Formatting dialog (Excel 2007), 365
Clear Rules option, 372
Color Scales option, 369
Data Bars option, 368
Highlight Cells Rules option, 366-368
Icon Sets option, 369
New Formatting Rule dialog, 370-372
Rules Manager dialog, 372
Top/Bottom Rules option, 368

conditional logic in Excel formulas
AND function, 360
AVERAGEIF function, 361
COUNTIF function, 361
IF function, 358-359
NOT function, 361
OR function, 360
SUMIF function, 361

configuring
AutoArchive feature (Outlook 2007), 630-632
slide shows, 526-528
workbooks, 265

contacts (Outlook 2007)
adding, 595-597
categorizing, 598-599
Contacts folder, 592-595
distribution lists, 599-602
editing, 599
folders, creating, 602
mail merge recipients, selecting from, 197
online status, checking, 597
removing, 599
scheduling

appointments, 605-608
meetings, 603-604

tasks, creating, 608-610
Content with Caption slide layout (PowerPoint 2007), 450

contextual tabs (application ribbons), 16

continuous section breaks, 56

contrast, adjusting in Word document images, 103

Contrast icon (Word Picture Tools Format ribbon), 103

converting
Access databases, 757-758
tables (Excel worksheets) to cell ranges, 334
text in Word tables, 169

Copy Cells option (AutoFill feature), 269

Copy Formatting Only option (AutoFill feature), 269

copying
text in documents, 43
worksheets, 302

color
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COUNTIF function, 354, 361

COUNTIFS function, 354

Create a New View dialog (Outlook 2007), 547-548

Criteria properties (queries), 697

Crop function (Picture Tools Size group), 399

Crop icon (Word Picture Tools Format ribbon), 110-111

cropping images in Word documents, 110-111

currency data types (Access queries), 698

custom fill lists, creating in Excel 2007, 273

Custom option (PowerPoint animations), 487

custom themes, creating for worksheets, 328

Custom View: Documents dialog (Outlook 2007), 545-547

custom views (worksheets), 286

Custom Views dialog, 286

Custom XML Data category (Document Inspector), 511

customizing
charts (Excel 2007), 394-396
Handout Master (PowerPoint 2007), 520
headers, 46-47
Notes Master (PowerPoint 2007), 519
page margins, 49-50
search folders (Outlook 2007), 636
status bar, 19
Word 2007, 58

cutting/pasting
Clipboard, 44
text in documents, 43

D
Data and Model section (Cell Styles gallery), 317

Data Bars option (Conditional Formatting dialog), 368

data entry via AutoFill feature, 267-269

Data group (Table Tools Layout tab), 169

data integrity
workbooks, 274, 279

encryption, 275-276
locking cells, 276-277
passwords, 275-276
worksheets, 277-278

worksheets, 277-278
data lookups (Excel 2007)

horizontal data lookups, 363-364
vertical data lookups, 362-363

Data tab (Excel 2007), 262, 399

databases, 650, 748
backups, 749, 761
Compact and Repair tool (Access 2007), 758-761

converting
Access 2007 databases to earlier formats, 758
earlier database formats to Access 2007, 757-758

creating, 653-657
database objects

exporting, 765-770
importing, 761-764
printing, 771-772

Exclusive Access, opening with, 750
front-end databases, distributing, 683
organizing data in, 651-652
record keys, 653
splitting, 683
tables

attaching documents to, 679-681
AutoNumber primary keys, 672
changing primary keys, 673
creating in Datasheet view (Access 2007), 657-659
creating in Design view (Access 2007), 659-660
defining relationships, 668
deleting relationships, 670-671
editing attached files, 681
exporting to Excel, 765
exporting to Word, 766-767
finding/replacing data, 677-678
importing data into, 674-676
Linked Table Manager (Access 2007), 756
linking, 751-752
linking to Excel worksheets, 755
linking to ODBC tables, 752, 754
manually entering data, 674
many-to-many relationships, 667
modifying field properties via Design view (Access

2007), 660-666
one-to-many relationships, 667
one-to-one relationships, 666
primary keys, 671-672
printing relationships, 670
removing attached files, 682
removing primary keys, 673
saving attached files, 682
setting primary keys, 672
sorting, 723

Datasheet view (Access 2007), 657-659, 724-726

Date() function (Access 2007), 699

date/time
Date option (Fill Series dialog), 272
date/time data types (Access queries), 698-699
date/time values, sorting data by (Access 2007), 723
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DateAdd(interval, number, date) function (Access
2007), 699

DateDiff(interval, date1, date2) function (Access 2007),
699

DatePart(interval, date) function (Access 2007), 699
Day/Week/Month view (Create a New View dialog), 548

days of the week, entering into workbooks via AutoFill
feature, 268-269

Decimal Places property (Access Design view), 663

Default Value property (Access Design view), 664

default view (PowerPoint 2007)
changing, 446, 448
Normal-Notes and Slide option, 447
Normal-Outline and Slide option, 446
Normal-Outline, Notes, and Slide option, 446
Normal-Slide Only option, 447
Normal-Thumbnails and Slide option, 447
Normal-Thumbnails, Notes, and Slide option, 446
Outline Only option, 447
Slide Sorter option, 448
The View Saved in the File option, 446

default views, configuring in workbooks, 265

defined names (Excel cells), 328
cell selection, 331
formula bar Name box, 330
managing, 332
New Name dialog, 329-330
rules for, 329

delaying email delivery, 553-555

deleting
building blocks, 137
comments

PowerPoint presentations, 508-509
Word documents, 230-231

contacts (Outlook 2007), 599
database table attachments, 682
distribution lists (Outlook 2007), 602
markups from PowerPoint presentations, 508-509
primary keys (database tables), 673
relationships (database tables), 670-671
tables of contents from Word documents, 186
text from documents, 41
worksheets from workbooks, 303

delivery receipts (email), 581-582

Design tab (Chart Tools dialog), 391, 394

Design view (Access 2007), 724-725
Allow Zero Length property, 665
Append Only property, 666
Caption property, 664

creating reports via, 733-736
Decimal Places property, 663
Default Value property, 664
Detail section, 734
Field Size property, 661
Format property, 661-663
forms, displaying in, 708
Group Header/Footer section, 734
IME Mode property, 665
IME Sentence Mode property, 665
Indexed property, 665
Input Mask property, 663-664
New Values property, 663
Page Footer section, 734
Page Header section, 734
Report Header/Footer section, 734
Required property, 665
Show Date Picker property, 666
Smart Tags property, 665
tables

creating, 659-660
modifying field properties, 660-666

Text Align property, 666
Text Format property, 666
Unicode Compression property, 665
Validation Rule property, 664
Validation Text property, 665

Detail section (Access Design view), 734

Detailed Address Cards view (Contacts folder), 594

Developer tab (Excel ribbon), 263

Different First Page check box (Header and Footer Tools
Design tab), 46

Different Odd & Even Pages check box (Header and Footer
Tools Design tab), 46

digital signatures
creating, 248-249, 572-573
email, 578, 628
Word documents, inserting in, 250-251

Distributed (Indent) option (Excel Format Cells dialog,
Alignment tab), 321

distributing workbooks, 429

distribution lists (Outlook 2007), 599-602

.doc file format, 39

.docm file format, 39

Document Inspector (PowerPoint presentations), 510-512

documents (Word 2007)
Access database tables, exporting to, 766-767
bibliographies, 191
blank documents, opening, 30

date/time
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building blocks, inserting into documents, 134
closing, 21
comments

editing, 228
inserting, 227-228
removing, 230-231
reviewing, 229-230

comparing, 220-222
compatibility checks, 253
controlling access to, 246-247
creating

applying templates, 31-35
entering text in, 35-36
opening blank documents, 30

database tables, attaching to, 679-682
digital signatures, inserting into documents, 250-251
Document Inspector, 243-245
editing

copying text, 43
cutting/pasting text, 43
deleting text, 41
finding/replacing text, 42-43
marking documents as final, 251
replacing text, 41-43
selecting text, 40-41

embedded links, 161-163
encrypting, 246
endnotes, inserting, 187
Excel data, inserting into documents, 158, 161
finding via keyword searches, 57
footers, adding to documents, 47
footnotes, inserting, 186-187
formatting

applying styles, 72
backgrounds, 76
borders, 76
character styles, 70
creating new styles, 71-72
Home tab icons, 79-80
linked styles, 70
list styles, 70
paragraph styles, 70
Quick Styles, 73
shortcut menu, 80
Style task pane, 70
table styles, 70-71
themes, 74-75
viewing styles, 68
watermarks, 76-79

gutters, 49
headers

adding to documents, 45
customizing, 46-47

images
captioning, 114-115
cropping, 110-111
formatting, 101-110, 116-120
inserting into autoshapes, 97
inserting into charts, 91, 99-100
inserting into clip art, 91-93
inserting into free-form shapes, 99
inserting into pictures, 90-92
inserting into SmartArt graphics, 91, 95-96
inserting text in shapes, 99
resizing, 111-112
rotating, 112-113
wrapping text around images, 116-117

initializating, 58
keyword searches, 57
line breaks, 50-52
links, adding to, 121-122, 160
merging, 192-203, 222-223
naming, 37
navigating, 216-219
opening, 20
page breaks, 48-53
page margins, 48-50
page numbering, 53

all pages, 54
beginning page numbers after the first page, 54-55
restarting, 55-57

paragraphs
forcing page breaks before paragraphs, 53
keeping lines together, 52
keeping together, 52

password protection, 252
printing, 22
properties of, improving searchability via, 57
Quick Tables, inserting, 158
references, 182

adding to tables of contents, 185
creating bibliographies, 191
deleting sources, 190
editing source, 189
inserting citations in, 190
source management, 188-190

reviewing
comments, 227-231
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comparing documents, 220-222
merging documents, 222-223
tracking changes, 224-232

saving, 37-39
section breaks (continuous), 56
sections, 50
sharing

inspecting for hidden/private information, 243-245
managing metadata, 240-242

tables of contents, 182
adding references to, 185
deleting, 186
formatting, 185
updating content in, 186
updating page numbers in, 186

templates
applying via Microsoft Office Online, 33-35
Blank and Recent option (New Document dialog,

Templates section), 31
choosing, 31-33
Installed Templates option (New Document dialog,

Templates section), 32
My Templates option (New Document dialog,

Templates section), 32
New from Existing option (New Document dialog,

Templates section), 33
tracking changes

accepting/rejecting changes, 228-229
hiding/displaying tracking markups, 226
limiting editing/formatting of, 231-232
reviewing changes, 229-230
Track Changes feature (Word 2007), 224-225
tracking balloons, 225-226

Word tables
inserting, 156-163
sorting data, 169-170

Documents view (Outlook 2007), 544

.docx file format, 38-39

doughnut charts (Excel 2007), 388

Down option (Fill button), 270

Draw Border group (Table Tools Design tab), 166

Draw Table tool (Word 2007), 159

E
edge effects, adding to images in Word documents, 109

Edit Custom Lists button (Excel Options button), 273

editing
cell ranges in workbooks, 421-422

comments
PowerPoint presentations, 508
Word documents, 228

contacts (Outlook 2007), 599
distribution lists (Outlook 2007), 601
documents

copying text, 43
cutting/pasting text, 43
deleting text, 41
finding/replacing text, 42-43
marking documents as final, 251
replacing text, 41-43
selecting text, 40-41

images in Word documents
cropping images, 110-111
resizing images, 111-112
rotating images, 112-113

tracked changes in Word documents, 231-232
effects (image), adding to images in Word documents, 

108-110

electronic business cards, attaching to email, 571

email
attachments, 569

files as, 570-571
graphics as, 568-569

automated messages, 574-578
AutoReply feature

automated messages, 576-578
creating rules for, 576-577
message templates, 576
turning off rules, 578

calendars, sending, 613
categorizing via color, 622
creating, 549-550
digital signatures, 628
encryption, 579, 626-627
formatting

backgrounds, 564-567
bulleted lists, 559
changing fonts, 558
charts, 568
Clip Art, 568
equations, 564
graphics, 568-569
horizontal lines, 562
images, 568-569
numbered lists, 559
pictures, 568-569
shapes, 568
SmartArt, 568

documents (Word 2007)
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stationery, 556-557
symbols, 563
tables in, 560-562
themes, 564

message templates, 576
Out of Office Assistant, 574-576
security

digital signatures, 578
encryption, 579

sending
assigning expiration dates to, 552
assigning levels of importance to, 550-552
delaying delivery, 553-555
setting delivery options, 550-555

signatures
applying, 578
creating, 572-573

tracking
delivery receipts, 581-582
flags, 580-581
request reads, 581-582

embedded links in Word documents, 161-163

Emphasis effects (PowerPoint animations), 490

emptying (clearing) Clipboard, 44

encryption
documents, 246
email, 579, 626-627

endnotes, inserting into Word documents, 187

Entrance effects (PowerPoint animations), 489

envelopes, printing, 203-204

equations
email, adding to, 564
Equation gallery, adding to, 563-564

Eraser option (Table Tools Design tab), 166

error messages, Compatibility Checker, 513

exams
exam preparation strategies, 7
exam-taking strategies, 12
MCAS exams, 8-9
practice exams, 8-9
pretests, purchasing vouchers for, 7
study resources, 10-11

Excel 2007
Access database tables, exporting to, 765
AutoFill feature, 267-269
cells

editing cell ranges, 421-422
filtering data, 405-407

grouping data for outlines, 399
inserting subtotals into outlines automatically, 

400-401
inserting subtotals into outlines manually, 400
printing selected cell ranges, 433
sorting data, 403-404

Chart Tools dialog
Design tab, 391, 394
Format tab, 392-395
Layout tab, 392-393

charts, 384
adding illustrations to, 396-397
area charts, 386
bar charts, 386
bubble charts, 388
column charts, 385
creating, 99-100, 389-390
customizing, 394-396
customizing illustrations in, 398-399
doughnut charts, 388
formatting, 391-393
inserting into Word documents, 91, 99-100
line charts, 385
moving, 395
pie charts, 385
radar charts, 389
scatter (XY) charts, 387
stock charts, 387
surface charts, 387

Conditional Formatting dialog
Clear Rules option, 372
Color Scales option, 369
Data Bars option, 368
Highlight Cells Rules option, 366-368
Icon Sets option, 369
New Formatting Rule dialog, 370-372
Rules Manager dialog, 372
Top/Bottom Rules option, 368

Excel Options dialog (Microsoft Office button), 
263-265

Edit Custom Lists button, 273
Popular tab, 304

fill lists, creating, 273
Format Cells dialog, 309

Alignment tab, 321
Font tab, 310

formulas, 346
absolute cell references, 350
arithmetic operators, 347-348
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calculating results via array formulas, 357
conditional counts/averages, 354
conditional logic in, 358-361
data lookups, 362-364
displaying, 373
formatting cells via, 365-372
formatting text via, 364-365
logical test operators, 358
printing, 373-374
R1C1 cell references, 351
relative cell references, 348-350
summarizing data via Subtotal feature, 354-357
summarizing data via SUMIF function, 352-353
summarizing data via SUMIFS function, 353

Home tab, Font group, 308
Insert tab, Illustration group, 396-399
Insert Worksheet button, 299
New Name dialog, defined cell names, 329-330
Orientation menu, 320
outlines

collapsing/expanding, 402
grouping data, 399
inserting subtotals automatically, 400-401
inserting subtotals manually, 400

printing
changing active printers, 432-433
reviewer comments, 434-435
selected cell ranges, 433
setting worksheet print areas, 433-434
workbooks, 434
worksheets, 434

ribbon
Add-ins tab, 263
Data tab, 262
Developer tab, 263
Formulas tab, 262
Home tab, 262, 270-271
Insert tab, 262
Page Layout tab, 262
Review tab, 262
View tab, 262, 281

spreadsheet objects, inserting into Word documents,
158

workbooks
adding worksheets to, 299
changing number of worksheets in, 300
configuring, 265
creating, 264-266
data integrity in, 274-279

deleting worksheets from, 303
distributing, 429
editing cell ranges, 421-422
encryption, 275-276
limiting access to, 428-429
memory and, 265
moving worksheets in, 301
passwords, 275-276
printing, 434
protecting, 423
resolving change conflicts, 428
saving, 266, 429-431
sharing, 426-429
switching between, 286
tracking changes in, 418-421

worksheets
adding cell borders, 315-316
adding color to cells, 324
adding data bars to cells, 368
adding gradient color scales to cell ranges, 369
adding icons to cells, 369
adding to workbooks, 299
adding total rows to tables, 335
aligning cell data, 317-318, 321-322
centering aligned cell data, 318
changing backgrounds, 303-304
changing cell fonts, 308-310
changing cell orientation (rotation), 320
changing gridline color, 324
changing number of worksheets in workbooks, 300
changing page number sequence, 307
changing page numbers, 307
changing row height, 313-314
changing tab color, 301
changing views, 279-281
changing width, 313-314
conditional cell formatting via Excel formulas, 

365-369
controlling multiple worksheets, 285
converting tables to cell ranges, 334
copying, 302
creating tables, 333
custom views, 286
data integrity in, 277-278
defined cell names, 328-332
deleting cells, 312-313
deleting columns, 312-313
deleting from workbooks, 303
deleting rows, 312-313

Excel 2007
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exporting data to database tables, 674-675
filtering data, 405-407
fitting cell data to cell size, 323-324
formatting, 304
formatting table data, 334
Freeze Panes menu, 284
Full Screen view, 280
grouping cell data for outlines, 399
hiding cell data, 325
hiding columns, 326
hiding rows, 326
highlighting cells, 366-368
indenting cell data, 318
inserting cell subtotals into outlines automatically,

400-401
inserting cell subtotals into outlines manually, 400
inserting cells, 310-311
inserting columns, 311-312
inserting embedded links into Word documents,

161-163
inserting page numbers into multiple worksheets,

306
inserting page numbers into single worksheets, 305
inserting rows, 311
inserting subtotals into cell ranges, 355
linking to database tables, 755
merging aligned cell data, 318
merging cells, 324-325
moving in workbooks, 301
Multiple Windows view, 282-283
name scope, 330
Normal view, 280
Page Break Preview view, 280
Page Layout view, 280
printing, 434
protecting, 424-425
renaming, 300
setting print areas, 433-434
setting table design options, 335
sorting data, 403-404
Split option, 284-285
styling cells, 316-317
table cell names, 328
themes, 327-328
viewing multiple worksheets, 285
wrapping cell data, 319

Exchange Servers, Outlook accounts, 632-633

Exclusive Access (Access 2007), opening databases via, 750

Exit button (Microsoft Office Button), 16, 21

Exit effects (PowerPoint animations), 490

expanding/collapsing outlines (Excel 2007), 402

expiration dates
email, assigning to, 552
Word document permissions, 247

exporting/importing database objects, 761
Access databases, 762-763

Excel, 765
Word, 766-767

external sources, 764
HTML documents, 769
Mail Merge documents, 769-770
XML files, 768

F
Fade option (PowerPoint animations), 487

Fades and Dissolves option (PowerPoint transitions), 483

Field Size property (Access Design view), 661

Fields button (Custom View: Documents dialog), 545

figure captions, images in Word documents, 114-115

Fill button (Excel ribbon, Home tab), 270-272

fill color, changing in Excel charts, 396

Fill Days option (AutoFill feature), 269

fill lists, creating in Excel 2007, 273

Fill option (Excel Format Cells dialog, Alignment tab), 321

Fill Series dialog, 272

Fill Series option (AutoFill feature), 269

Fill Weekdays option (AutoFill feature), 269

Fill Without Formatting option (AutoFill feature), 269

Fill-In rule (Word Rules menu), 201

fills (gradient)
email backgrounds, 567
slide master backgrounds (PowerPoint presentations),

468
Filter button (Custom View: Documents dialog), 546

filtering data
Access 2007, 718

Advanced Filter, 721-722
Filter by Field option, 719
Filter by Selection option, 720

cell data in worksheets (Excel 2007)
AutoFilter function, 405-406
custom filters, 406-407
wildcards, 407

final, marking Word documents as, 251

Find command, 42
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finding
data

database tables, 677-678
Excel formulas, 362-364

documents
keyword searches, 57
text, 42-43

First Column option (Table Tools Design tab), 164

flags (email), 580-581

Fly In option (PowerPoint animations), 487

fonts (text)
cells (worksheets), changing in, 308-310
email, changing in, 558
workbooks, configuring in, 265

footers/headers
documents, adding to, 47
Group Header/Footer section (Access Design view),

734
Page Footer section (Access Design view), 734
Page Header section (Access Design view), 734
repeat header rows option (Table Tools Layout tab),

169
Report Header/Footer section (Access Design view),

734
slide masters (PowerPoint presentations), adding to,

469-470
footnotes, inserting into Word documents, 186-187

Format button (worksheets), 313

Format Cells dialog (Excel 2007), 309
Alignment tab, 321
Font tab, 310

Format Columns button (Custom View: Documents dialog),
547

Format property (Access Design view), 661-663

Format tab (Chart Tools dialog), 392-393
Picture tools, 398-399
Quick Styles tools, 395

formatting
Automatic Formatting button (Custom View:

Documents dialog), 547
bulleted lists, 140-141, 145
charts (Excel 2007), 391-393
Copy Formatting Only option (AutoFill feature), 269
documents (Word 2007)

applying styles, 72
backgrounds, 76
borders, 76
character styles, 70
creating new styles, 71-72

Home tab icons, 79-80
linked styles, 70
list styles, 70
paragraph styles, 70
Quick Styles, 73
references, 182
shortcut menu, 80
Style task pane, 70
table styles, 70-71
themes, 74-75
viewing styles, 68
watermarks, 76-79

email
attachments, 569-571
backgrounds, 564-567
bulleted lists, 559
changing fonts, 558
charts, 568
Clip Art, 568
equations, 564
graphics, 568-569
horizontal lines, 562
images, 568-569
numbered lists, 559
pictures, 568-569
shapes, 568
SmartArt, 568
stationery, 556-557
symbols, 563
tables, 560-562
themes, 564

Excel cells via Excel formulas, 365
adding data bars to cells, 368
adding gradient color scales to cell ranges, 369
adding icons to cells, 369
clearing formatting rules, 372
defining new formatting rules, 370-372
highlighting cells, 366-368
managing formatting rules, 372

Excel text via Excel formulas, 364-365
Fill Without Formatting option (AutoFill feature), 269
Format Columns button (Custom View: Documents

dialog), 547
images in Word documents, 101

applying picture borders, 107-108
applying picture effects, 108-110
applying picture shapes, 107
applying picture styles, 106
applying shading to text, 120

finding
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brightness, 102
changing images, 102, 105
contrast, 103
file compression, 104-105
highlighting text via borders, 118-119
inserting/formatting text in text boxes, 120
recoloring images, 101-103
resetting images, 105

numbered lists, 140-145
slide masters (PowerPoint presentations), 469
table data (Excel worksheets), 334
tables (Word 2007), 164

aligning cell margins, 168
aligning content in, 168
aligning text in, 168
applying borders to tables, 166
applying shading to tables, 166
bookmarks, 171
cell references, 170
formulas, 169, 172-173
inserting/deleting rows/columns, 167
merging cells, 167
predefined table styles, 165
sizing rows/columns, 168
sorting data, 169-170
splitting cells, 168
splitting tables, 168
Table Tools Design tab, 164-166
Table Tools Layout tab, 166-169

tables of contents (Word documents), 185
text, PowerPoint presentation text boxes, 456
tracked changes in Word documents, 231-232
worksheets, 304

adding cell borders, 315-316
adding color to cells, 324
aligning cell data, 317-318, 321-322
centering aligned cell data, 318
changing cell fonts, 308-310
changing cell orientation (rotation), 320
changing column width, 313-314
changing gridline color, 324
changing page number sequence, 307
changing page numbers, 307
changing row height, 313-314
defined cell names, 328-332
deleting cells, 312-313
deleting columns, 312-313
deleting rows, 312-313
fitting cell data to cell size, 323-324

hiding cell data, 325
hiding columns, 326
hiding rows, 326
indenting cell data, 318
inserting cells, 310-311
inserting columns, 311-312
inserting page numbers into multiple worksheets,

306
inserting page numbers into single worksheets, 305
inserting rows, 311
merging aligned cell data, 318
merging cells, 324-325
name scope in cells, 330
styling cells, 316-317
table cell names, 328
themes, 327-328
wrapping cell data, 319

forms (Access 2007)
creating, 701

blank forms, 705-707
Form tool, 702-703
Form Wizard, 703-705

Design view, displaying in, 708
modifying layout of, 709
sizing, 708
Split Form tool, 701

formulas
Excel, 346

absolute cell references, 350
arithmetic operators, 347-348
array formulas, 357
conditional counts/averages, 354
conditional logic in, 358-361
data lookups, 362-364
displaying, 373
formatting cells via, 365-372
formatting text via, 364-365
Formulas tab (Excel ribbon), 262
logical test operators, 358
printing, 373-374
R1C1 cell references, 351
relative cell references, 348-350
summarizing data via, 352-357

Word tables, 169, 172-173
free-form shapes, inserting into Word documents, 99

Freeze First Column option (Freeze Panes menu), 284

Freeze Panes menu, 284

front-end databases, distributing, 683

Full Screen view (worksheets), 280
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G
galleries, displaying from application ribbons, 17

glow effects, adding to images in Word documents, 109

Go to Footer button (Header and Footer Tools Design tab),
47

Go to Header button (Header and Footer Tools Design tab),
47

Go To Object feature (Select Browse Object gallery), 219

Good, Bad, and Neutral section (Cell Styles gallery), 317

gradients
email backgrounds, 567
slide master backgrounds (PowerPoint presentations),

468
graphics

charts (Excel 2007)
adding to, 396-397
customizing in, 398-399

email, adding to, 567-569
object boxes (PowerPoint presentations), adding to

clip art, 460
pictures, 459-460
SmartArt graphics, 458

slides (PowerPoint 2007)
adding to, 450
master backgrounds, 468

Word documents
captioning in, 114-115
editing in, 110-113
formatting in, 101-110, 118-120
inserting into, 90-100
wrapping text around images, 116-117

worksheets, adding as backgrounds, 303-304
greeting lines, inserting into mail merges, 198-199

gridlines (worksheets), changing color of, 324

Group By button (Custom View: Documents dialog), 545-546

Group function (Outline group), 399

Group Header/Footer section (Access Design view), 734

grouping slide elements (PowerPoint presentations), 462

Growth option (Fill Series dialog), 272

gutters, 49

H
handouts (PowerPoint presentations)

customizing, 520
printing handouts, 521

hard page breaks, 53

headers/footers
customizing, 46-47
documents, adding to, 45
Group Header/Footer section (Access Design view),

734
Header and Footer Tools Design tab, 46-47
Header Row option (Table Tools Design tab), 164
Page Footer section (Access Design view), 734
Page Header section (Access Design view), 734
repeat header rows option (Table Tools Layout tab),

169
Report Header/Footer section (Access Design view),

734
slide masters (PowerPoint presentations), adding to,

469-470
height, changing in rows (worksheets), 313-314

hidden/private information, inspecting Word documents for,
243-245

hiding
cell data (worksheets), 325
columns (worksheets), 326
rows (worksheets), 326
tracking markups in Word documents, 226

Highlight Cells Rules option (Conditional Formatting dialog),
366-368

highlighting
Excel cells, 366-368
text, Word document images, 118-119

HLOOKUP (horizontal lookup) function, 363-364

Home tab
Excel 2007, 262

Fill button, 270-272
Font group, changing cell fonts (worksheets), 308

Word 2007, formatting documents, 79-80
horizontal data lookups (Excel 2007), 363-364

horizontal lines, adding to email, 562

horizontally aligning cell data (worksheets), 317

HTML documents, exporting Access database objects to,
769

hyperlinks
database tables, 751

Excel worksheets, 755
Linked Table Manager (Access 2007), 756
ODBC tables, 752-754

embedded links
controlling in Word documents, 162-163
inserting into Word documents, 161

hyperlink data types (Access queries), 697-698
hyperlink values, sorting data by (Access 2007), 723

galleries, displaying from application ribbons
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linked tables, inserting into Word documents, 160-163
PowerPoint presentations

creating links within presentations, 495
inserting object links, 493-494
linking content to presentations, 493

slide shows, creating, 524-525
Word documents, adding to, 121-122

embedded links, 161-163
linked tables, 160-163

I
iCalendar, saving Calendar (Outlook 2007) as, 612

Icon Sets option (Conditional Formatting dialog), 369

Icon view (Create a New View dialog), 548

icons, adding to Excel cells, 369

ID (digital). See digital signatures

IF function, conditional logic in Excel formulas, 358-359

If…Then…Else rule (Word Rules menu), 201

Illustration group (Excel Insert tab), 396-399

images
charts (Excel 2007)

adding to, 396-397
customizing in, 398-399

email, adding to, 567-569
object boxes (PowerPoint presentations), adding to

clip art, 460
pictures, 459-460
SmartArt graphics, 458

slides (PowerPoint 2007)
adding to, 450
master backgrounds, 468

Word documents
captioning in, 114-115
editing in, 110-113
formatting in, 101-110, 118-120
inserting into, 90-100
wrapping text around images, 116-117

worksheets, adding as backgrounds, 303-304
IME Mode property (Access Design view), 665

IME Sentence Mode property (Access Design view), 665

importance (levels of), assigning to email, 550-552

importing/exporting database objects, 761
Access database tables, 762-763

Excel, 765
Word, 766-767

external sources, 764
HTML documents, 769

Mail Merge documents, 769-770
XML files, 768

indenting
cell data (worksheets), 318
text, 321

Indexed property (Access Design view), 665

initializing Word 2007 documents, 58

input masks
characters list, 663-664
Input Mask property (Access Design view), 663-664
sample input masks, 664

Insert tab (Excel 2007), 262, 396-399

Insert Table function (Word 2007), 157

Insert Worksheet button (Excel 2007), 299

Installed Templates option (New Document dialog,
Templates section), 32

Instant Search feature (Outlook 2007), 634-635

Invisible On-Slide Content category (Document Inspector),
511

J - K - L
Justify option, 271, 321

keyboards
key tips, 18-19
shortcuts

mail merges, 202
multilevel lists, 139
selecting text, 41

keys
primary keys, 671-673
record keys, 653

keyword searches, 57

labels
Labels group (Chart Tools Layout tab), 393
printing

recipient lists, 206-207
sheets of the same label, 205
single labels, 205

Landscape orientation (documents), 49

languages, changing in
Office 2007, 662
Word 2007, 59
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Last Column option (Table Tools Design tab), 164

Last Seven Days view (Outlook 2007), 544

Layout tab (Chart Tools dialog), 392-393

Left (Indent) with the Indent Value Set to Zero option (Excel
Format Cells dialog, Alignment tab), 321

Left option (Fill button), 270

line breaks, 50
orphans, 51-52
paragraphs, 52
widows, 51-52

line charts (Excel 2007), 385

Line Style option (Table Tools Design tab), 166

Line Weight option (Table Tools Design tab), 166

Linear option (Fill Series dialog), 272

linked styles (Word 2007), 70

Linked Table Manager (Access 2007), 756

links
database tables, 751

Excel worksheets, 755
Linked Table Manager (Access 2007), 756
ODBC tables, 752-754

embedded links
controlling in Word documents, 162-163
inserting into Word documents, 161

hyperlink data types (Access queries), 697-698
hyperlink values, sorting data by (Access 2007), 723
linked tables, inserting into Word documents, 160-163
PowerPoint presentations

creating links within presentations, 495
inserting object links, 493-494
linking content to presentations, 493

slide shows, creating, 524-525
Word documents, adding to, 121-122

embedded links, 161-163
linked tables, 160-163

lists
bulleted lists

adding to email, 559
creating, 137-138
formatting, 140-141, 145
sorting, 146

distribution lists (Outlook 2007), 599-602
list styles (Word 2007), 70
multilevel lists, creating, 138-139
numbered lists, 137

adding to email, 559
creating, 138
formatting, 140-145
sorting, 146

Phone List view (Contacts folder), 594
Trusted Publishers list (Outlook 2007), 626

locking cells (workbooks), 276-277

logic (conditional), Excel formulas
AND function, 360
AVERAGEIF function, 361
COUNTIF function, 361
IF function, 358-359
NOT function, 361
OR function, 360
SUMIF function, 361

logical test operators (Excel formulas), 358

lookups (data), Excel 2007
horizontal data lookups, 363-364
vertical data lookups, 362-363

M
macros, enabling/disabling in Outlook 2007, 625-626

mail merges
keyboard shortcuts, 202
Word documents, 192

controlling merges via rules, 200-201
creating recipient lists, 194-196
existing recipient lists, 196
exporting Access database objects to, 769-770
finishing merges, 203
inserting address blocks, 198-199
inserting greeting lines, 198-199
inserting merge fields, 198-200
previewing merged documents, 202
selecting recipients, 193-194
selecting recipients from Outlook Contacts, 197

Mail view (Outlook 2007), changing, 543

Mailings tab (Word 2007), Word document mail merges,
192

address blocks, inserting, 198-199
controlling via rules, 200-201
finishing merges, 203
greeting lines, inserting, 198-199
merge fields, inserting, 198-200
previewing merged documents, 202
recipients

recipient lists, 194-196
selecting, 193-194, 197

many-to-many relationships
Access queries, 696
database tables, 667

Last Column option (Table Tools Design tab)
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margins (pages)
applying to documents

Book Fold option, 50
custom margins, 49-50
Landscape orientation, 49
mirror margins, 49
Page Margin gallery, 48
Portrait orientation, 49
Two Pages per Sheet option, 50

Margins button (Page Layout tab), 48
Margins tab (Page Setup dialog), 49

markups, deleting from PowerPoint presentations, 508-509

master slides (PowerPoint 2007)
backgrounds, setting, 467-469
creating, 465-466
editing, 466-467
formatting, 469
headers/footers, adding to, 469-470

MCAS (Microsoft Certified Application Specialist) exams
exam preparation strategies, 7
exam-taking strategies, 12
questions, 8-9
study resources, 10-11

media objects, adding to object boxes (PowerPoint presen-
tations)

clip art, 460
media clips, 460
pictures, 459-460
SmartArt graphics, 458

meetings, scheduling (Outlook 2007), 603-604

memo data types (Access queries), 697-698

memory, workbooks, 265

menus, displaying application ribbons from, 16

merging
cells

aligned cell data (worksheets), 318
Word tables, 167
worksheet cells, 324-325

mail merges
keyboard shortcuts, 202
Word documents, 192-203, 222-223, 769-770

Merge group (Table Tools Layout tab), 167
Merge Record# rule (Word Rules menu), 201
Merge Sequence# rule (Word Rules menu), 201
merged envelopes, printing, 204

messages (email)
attachments

files as, 570

graphics as, 568-569
Outlook items as, 570-571

automated messages
AutoReply, 576-578
Out of Office Assistant, 574-576

calendars, sending, 613
categorizing via color, 622
creating, 549-550
digital signatures, 628
encryption, 579, 626-627
formatting

background, 565
backgrounds, 564-567
bulleted lists, 559
changing fonts, 558
charts, 568
Clip Art, 568
equations, 564
graphics, 568-569
horizontal lines, 562
images, 568-569
numbered lists, 559
pictures, 568-569
shapes, 568
SmartArt, 568
stationery, 556-557
symbols, 563
tables, 560-562
themes, 564

Message Timeline view (Outlook 2007), 544
Messages view (Outlook 2007), 543
Messages with AutoPreview view (Outlook 2007), 543
security

digital signatures, 578
encryption, 579

sending
assigning expiration dates to, 552
assigning levels of importance to, 550-552
delaying delivery, 553-555
setting delivery options, 550-555

signatures
applying, 578
creating, 572-573

templates, 576
tracking

delivery receipts, 581-582
flags, 580-581
request reads, 581-582
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metadata, managing in Word documents, 240-242

Microsoft Office button
Close link, 15, 21
Excel Options button, 263-265, 273, 304
Exit button, 16, 21
New link, 15, 264-266
Open link, 15, 20
Options button, 16
Prepare link, 15
Print link, 15, 22
Publish link, 15
Save As link, 15, 275
Save link, 15, 267
Send link, 15

Microsoft Office Online, applying templates to documents,
33-35

mini toolbar, 18

mirror margins, 49

money, currency data types (Access queries), 698

months of the year, entering into workbooks via AutoFill
feature, 269

Motion Paths effects (PowerPoint animations), 490

mouse, selecting text, 40

moving
charts (Excel 2007), 395
worksheets in workbooks, 301

multilevel lists, creating, 138-139

Multiple Windows view (worksheets), 282-283

multiple worksheets, controlling, 285

multiple-choice questions (MCAS exams), 8

My Templates option (New Document dialog, Templates
section), 32

N
name scope (Excel cells), 330

naming
building blocks, 136
documents, 37
worksheets, 300

navigating Word documents
Select Browse Object features, 217-219
Thumbnails view, 216-217

New Document dialog, 31-33

New Formatting Rule dialog (Conditional Formatting dialog),
370-372

New from Existing option (New Document dialog, Templates
section), 33

New link (Microsoft Office Button), 15, 264-266

New Name dialog (Excel), defined cell names, 329-330

New Values property (Access Design view), 663

Next Record If rule (Word Rules menu), 201

Next Record rule (Word Rules menu), 201

Normal view
PowerPoint 2007, 445
worksheets, 280

Normal-Outline, Notes, and Slide option (PowerPoint default
view), The, 446-447

Normal-Thumbnails, Notes, and Slide option (PowerPoint
default view), The, 446-447

NOT function, conditional logic in Excel formulas, 361

Notes Master (PowerPoint 2007), customizing, 519

Notes pages, printing, 519

Notes pane (PowerPoint 2007), 445

Now function (Access 2007), 699

Number Format section (Cell Styles gallery), 317

numbers
alphanumeric value fields, sorting data by (Access

2007), 723
AutoNumber data types (Access queries), 698
document pages, 53

all pages, 54
beginning page numbers after the first page, 54-55
restarting in documents, 55-57

number data types (Access queries), 698
numbered lists, 137

creating, 138
email, adding to, 559
formatting, 140-145
sorting, 146

numeric value fields, sorting data by (Access 2007), 723
numerical data series, entering into workbooks via

AutoFill feature, 269

O
object boxes (PowerPoint presentations), adding

charts to, 457-458
clip art to, 460
media clips to, 460
pictures to, 459-460
SmartArt graphics to, 458
tables to, 456

ODBC tables, linking to database tables, 752-754

Off-Slide Content category (Document Inspector), 511

Office 2007
Language options, 662
Regional options, 662

metadata, managing in Word documents
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user interface, 14
application ribbons, 16-17
key tips, 18-19
Microsoft Office Button, 15-16, 275
mini toolbar, 18
Quick Access Toolbar, 17
status bar, 19

Office Online (Microsoft), applying templates to documents,
33-35

one-to-many relationships
Access queries, 696
database tables, 667

one-to-one relationships
Access queries, 696
database tables, 666

Open link (Microsoft Office Button), 15, 20

opening documents, 20

Options button (Microsoft Office Button), 16

OR function, conditional logic in Excel formulas, 360

Or properties (queries), 697

ordering slide elements (PowerPoint presentations), 
461-462

Organization pane (PowerPoint 2007), 445

organizing data in databases, 651-652. See also lists

Orientation menu (Excel 2007), 320

orphans/widows (line/page breaks), 51-52

Other Settings button (Custom View: Documents dialog), 546

Out of Office Assistant (Outlook 2007), 574-576

Outline group (Excel Data tab), Group function, 399

Outline Only option (PowerPoint default view), The, 447

outlines
Excel 2007, 399-402
PowerPoint presentations, 521

Outlook 2007
appointments

creating, 605-606
recurring appointments, 607-608

AutoArchive feature, 629-632
AutoReply feature, 576-578
Calendar

saving as iCalendar, 612
sending via email, 613
sharing, 613-614

contacts
adding, 595-597
assigning tasks, 610
categorizing, 598-599
Contacts folder, 592-594

creating folders, 602
creating tasks, 608-610
distribution lists, 599-602
editing, 599
online status checks, 597
removing, 599
scheduling appointments, 605-608
scheduling meetings, 603-604
selecting mail merge recipients from, 197

Create a New View dialog, 547-548
custom views

creating, 547-548
modifying existing views, 545-547

distribution lists, 599-602
Documents view, 544
email

attachments, 569-571
automated messages, 574-578
backgrounds, 564-567
bulleted lists in, 559
categorizing via color, 622
changing fonts, 558
charts in, 568
Clip Art in, 568
creating, 549-550
digital signatures, 628
encryption, 579, 626-627
equations in, 564
formatting, 556-571
graphics in, 568-569
horizontal lines in, 562
images in, 568-569
message templates, 576
numbered lists in, 559
pictures in, 568-569
security, 578-579
sending, 550-555
sending calendars via, 613
setting delivery options, 550-555
shapes in, 568
signatures, 572-573, 578
stationery, 556-557
symbols in, 563
tables in, 560-562
themes in, 564
tracking, 580-582

Exchange Server accounts, 632-633
Format Text tab, formatting fonts via, 558
Last Seven Days view, 544
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Mail view, changing, 543
Message tab, formatting fonts via, 558
Message Timeline view, 544
Messages view, 543
Messages with AutoPreview view, 543
offline, working, 632-633
Out of Office Assistant, 574-576
Outlook Data Files view, 544
searches, 633

Instant Search feature, 634-635
search folders, 636-640

security
digital signatures, 628
enabling/disabling add-ins, 623-624
enabling/disabling macros, 625-626
encryptions, 626-627
Trusted Publishers list, 626

Sent To view, 544
stationery, 556-557
tasks

assigning, 610
creating, 608-610

Trust Center
digital signatures, 628
email encryption, 627
enabling/disabling add-ins, 623-624
enabling/disabling macros, 625-626
Trusted Publishers list, 626

Unread Messages in This Folder view, 544
Outlook Data Files view, 544, 595

P
packaging PowerPoint presentations on CD, 530-532

page breaks, 50
hard page breaks, 53
orphans, 51-52
Page Break Preview view (worksheets), 280
paragraphs

forcing breaks before paragraphs, 53
keeping lines together, 52
keeping together, 52

soft breaks, 48
widows, 51-52

Page Footer section (Access Design view), 734

Page Header section (Access Design view), 734

Page Layout tab, 48, 262

Page Layout view (worksheets), 280

page margins, applying to documents, 48-50

page numbering, 53
all pages, 54
beginning page numbers after the first page, 54-55
restarting in documents, 55-57
worksheets

changing in, 307
changing numbering sequence, 307
into multiple worksheets, 306
into single worksheets, 305

Page Setup dialog, Margins tab, 49

pagination
line breaks, 50-52
page breaks, 50

forcing before paragraphs, 53
hard page breaks, 53
widows/orphans, 51-52

page margins
custom margins, 49-50
Page Margin gallery, 48

page numbering, 53
all pages, 54
beginning page numbers after the first page, 54-55
restarting in documents, 55-57

paragraphs
forcing page breaks before paragraphs, 53
keeping lines together, 52
keeping together, 52

section breaks (continuous), 56
paragraphs

keeping lines together, 52
keeping together, 52
page breaks, forcing before paragraphs, 53
paragraph styles (Word 2007), 70

passwords
PowerPoint presentations, 514
Word documents, 252
workbooks, 275-276

patterns, email backgrounds, 567

Pen Color option (Table Tools Design tab), 166

peripherals
keyboards

key tips, 18-19
shortcuts, 41, 139, 202

mouse, selecting text, 40
permissions, setting in documents, 246-247

personalizing Word 2007, 58

Phone List view (Contacts folder), 594

Outlook 2007
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pictures
email, adding to, 567

inserting pictures as attachments, 568-569
inserting pictures into message body, 568

Excel charts, adding to, 396
object boxes (PowerPoint presentations), adding to,

459-460
Picture tools (Chart Tools Format tab), 106, 398-399
Picture Tools Format ribbon (Word 2007), 101

Brightness icon, 102
Change Picture icon, 105
Compress Pictures icon, 104-105
Contrast icon, 103
Crop icon, 110-111
Picture Border icon, 107-108
Picture Effects icon, 108-110
Picture Shapes icon, 107
Picture Styles icon, 106
Recolor icon, 103
Reset Picture icon, 105
Size icon, 111-113

Picture with Caption slide layout (PowerPoint 2007),
450

slide master backgrounds (PowerPoint presentations),
468

Word documents, inserting into, 90-92
pie charts (Excel 2007), 385

Popular tab (Excel Options dialog), 304

Portrait orientation (documents), 49

PowerPoint 2007
default view

changing, 446, 448
Normal-Notes and Slide option, 447
Normal-Outline and Slide option, 446
Normal-Outline, Notes and Slide option, 446
Normal-Slide Only option, 447
Normal-Thumbnails and Slide option, 447
Normal-Thumbnails, Notes and Slide option, 446
Outline Only option, 447
Slide Sorter option, 448
The View Saved in the File option, 446

Handout Master, customizing, 520
Normal view, 445
Notes Master, customizing, 519
Notes pane, 445
Organization pane, 445
Presentation pane, 445, 482-483
presentations

adding charts to object boxes, 457-458
adding clip art to object boxes, 460

adding graphics to slides, 450
adding headers/footers to slide masters, 469-470
adding media clips to object boxes, 460
adding object boxes to, 456
adding pictures to object boxes, 459-460
adding SmartArt graphics to object boxes, 458
adding sound to slide transitions, 484-485
adding tables to object boxes, 456
adding text boxes to, 455
adding text to slides, 450
aligning slide elements, 462-465
applying custom animations to slides, 488, 491
applying standard animations to slides, 487-488
applying templates to, 452-453
applying themes to slides, 450-452
applying transition settings to all slides, 486
applying transitions to slides via Presentation pane,

482-483
applying transitions to slides via Slide Sorter, 484
changing slide layouts, 449-450
changing slide transition speed, 485
comments, 506-509
Compatibility Checker, 512-513
configuring advance slide setting, 486
configuring slide shows, 526-528
creating custom slide animations, 489-490
creating links within, 495
creating slide masters, 465-466
creating slide shows, 522-525
creating templates for, 471
deleting markup, 508-509
Document Inspector, 510-512
editing slide masters, 466-467
formatting slide masters, 469
formatting text in text boxes, 456
grouping slide elements, 462
inserting object links within, 493-494
linking content to presentations, 493
modifying custom slide animations, 492
ordering slide elements, 461-462
packaging on CD, 530-532
passwords, 514
printing handouts, 521
printing Notes pages, 519
printing outlines, 521
printing slides, 515-517
rehearsing, 528-529
removing custom slide animation effects, 492
removing transitions from slides, 486
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reviewing, 506-509
saving, 453-454
security, 509, 514
setting default slide show settings, 526
setting slide master backgrounds, 467-469
slide animation options, 487

Rehearsal toolbar, 528-529
slide show, 445
slide shows

configuring, 526-528
creating basic slide shows, 522-523
creating hyperlinked slide shows, 524-525
setting default settings, 526

Slide Sorter, 445, 484
slides

adding graphics to, 450
adding headers/footers to slide masters, 469-470
adding sound to transitions, 484-485
adding text to, 450
aligning elements, 462-465
animation options, 487
applying custom animations to slides, 488, 491
applying standard animations to slides, 487-488
applying themes to, 450-452
applying transition settings to all slides, 486
applying transitions via Presentation pane, 482-483
applying transitions via Slide Sorter, 484
Blank layout, 450
changing layout of, 449-450
changing transition speed, 485
Comparison layout, 450
configuring advance slide setting, 486
Content with Caption layout, 450
creating custom animations, 489-490
creating slide masters, 465-466
editing slide masters, 466-467
formatting slide masters, 469
grouping elements, 462
modifying custom animations, 492
ordering elements, 461-462
Picture with Caption layout, 450
printing, 515-517
removing custom animation effects, 492
removing transitions from, 486
Section Header layout, 449
setting slide master backgrounds, 467-469
Title and Content layout, 449
Title Only layout, 450
title slides, 449
Two Header layout, 449

starting, 444
workspace view, changing, 445

practice exams, 11
multiple-choice questions, 8
sequencing questions, 8-9
simulation questions, 9

predefined themes, adding to worksheets, 327

preparation strategies (MCAS exams), 7

Prepare link (Microsoft Office Button), 15

Presentation Notes category (Document Inspector), 511

Presentation pane (PowerPoint 2007), 445, 482-483

presentations (PowerPoint 2007)
CD, packaging on, 530-532
comments, 506

deleting from slides, 508-509
editing, 508
inserting on slides, 507
reviewing, 507

Compatibility Checker, 512-513
Document Inspector, 510-512
handouts, printing, 521
linking

content to presentations, 493
creating links within presentations, 495
inserting object links, 493-494

markups, deleting, 508-509
Notes pages, printing, 519
object boxes

adding, 456
adding charts to, 457-458
adding clip art to, 460
adding media clips to, 460
adding pictures to, 459-460
adding SmartArt graphics to, 458
adding tables to, 456

outlines, printing, 521
passwords, 514
rehearsing, 528-529
reviewing, 506-509
saving, 453-454
security, 509, 514
slide shows

configuring, 526-528
creating, 522-525
setting default settings, 526

slides
adding graphics to, 450
adding headers/footers to slide masters, 469-470

PowerPoint 2007
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adding sound to transitions, 484-485
adding text to, 450
aligning elements, 462-465
animation options, 487
applying custom animations to slides, 488, 491
applying standard animations to slides, 487-488
applying themes to, 450-452
applying transition settings to all slides, 486
applying transitions via Presentation pane, 482-483
applying transitions via Slide Sorter, 484
changing layouts of, 449-450
changing transition speed, 485
configuring advance slide setting, 486
creating custom animations for, 489-490
creating slide masters, 465-466
editing slide masters, 466-467
formatting slide masters, 469
grouping elements, 462
modifying custom animations for, 492
ordering elements, 461-462
printing, 515-517
removing custom animation effects, 492
removing transitions from, 486
setting slide master backgrounds, 467-469

templates
applying, 452-453
creating, 471

text boxes
adding, 455
formatting text in, 456

preset effects, adding to images in Word documents, 108

pretest vouchers, purchasing, 7

previewing
merged documents, 202
printing process. See printing, Print Preview option

(Microsoft Office Button, Print link)
primary keys (database tables), 671

AutoNumber primary keys, 672
changing, 673
removing, 673
setting, 672

printing
database objects, 771-772
documents, 22
envelopes, 203-204
Excel 2007

changing active printers, 432-433
reviewer comments, 434-435

selected cell ranges, 433
setting worksheet print areas, 433-434
workbooks, 434
worksheets, 434

formulas (Excel), 373-374
handouts, PowerPoint presentations, 521
labels

recipient lists, 206-207
sheets of the same label, 205
single labels, 205

Notes pages, PowerPoint presentations, 519
outlines, PowerPoint presentations, 521
Print link (Microsoft Office Button), 15, 22
Print option (Microsoft Office Button, Print link), 22
Print Preview option (Microsoft Office Button, Print

link), 22
Quick Print feature, database objects, 772
relationships (database tables), 670
slides (PowerPoint 2007), 515-517

private/hidden information, inspecting Word documents for,
243-245

Properties group (Chart Tools Layout tab), 393

Protect Sheet dialog, 277

Protect Structure and Windows dialog, 279

protecting
workbooks, 423
worksheets, 424-425

Publish link (Microsoft Office Button), 15

purchasing pretest vouchers, 7

Push and Cover option (PowerPoint transitions), 483

Q
queries (Access 2007)

applying, 700
creating, 694-699
Criteria properties, 697
many-to-many relationships, 696
modifying, 700
one-to-many relationships, 696
one-to-one relationships, 696
Or properties, 697
Query Builder (Outlook 2007), 634-635
Query Design view, 695-697
Show properties, 697
Sort properties, 696
sorting, 723-726
SQL statements, viewing, 699-700
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questions
multiple-choice questions, 8
sequencing questions, 8-9
simulation questions, 9

Quick Access Toolbar, 17

Quick Parts feature (Word 2007), 132-137

Quick Print feature
database objects, 772
Microsoft Office Button, Print link, 22

Quick Styles (Word 2007), 73

Quick Styles tools (Chart Tools Format tab), 395

Quick Tables (Word 2007)
email, adding tables to, 560-561
tables, adding to Quick Tables, 560
Word documents, inserting into, 158

R
R1C1 cell references (Excel formulas), 351

radar charts (Excel 2007), 389

Random option (PowerPoint transitions), 483

recoloring images in Word documents, 101-103

record keys, 653

recurring appointments, creating via Outlook 2007, 607-608

references
table of contents, adding to, 185
Word documents, 182

creating bibliographies, 191
deleting sources, 190
editing sources, 189
inserting citations in, 190
source management, 188-190

reflection effects, adding to images in Word documents, 109

Regional options (Office 2007), 662

Rehearsal toolbar (PowerPoint 2007), 528-529

rejecting/accepting tracked changes in Word documents,
228-229

relationship symbols (Access Query Design view), 696

relationships (database tables)
defining, 668
deleting, 670-671
many-to-many relationships, 667
one-to-many relationships, 667
one-to-one relationships, 666
printing, 670

relative cell references (Excel formulas), 348-350

removing
building blocks, 137
comments from Word documents, 230-231
contacts (Outlook 2007), 599
database table attachments, 682
distribution lists (Outlook 2007), 602
primary keys (database tables), 673
sharing status from workbooks, 428-429
worksheets from workbooks, 303

renaming
building blocks, 136
worksheets, 300

replacing text in documents, 41-43

Report Header/Footer section (Access Design view), 734

Report Wizard (Access 2007), creating reports via, 727-730

reports (Access 2007), 726
creating via

blank reports, 731-733
Design view, 733-736
Report Wizard, 727-730

modifying, 736-737
request reads (email), 581-582

Required property (Access Design view), 665

Reset Picture icon (Word Picture Tools Format ribbon), 105

Reset Window Position option (worksheets), 285

resetting images in Word documents, 105

resizing images in Word documents, 111-112

Review tab (Excel ribbon), 262

reviewer comments in Excel 2007 documents, printing, 
434-435

reviewing Word documents
comments, 227-230
comparing documents, 220-222
merging documents, 222-223
tracking changes, 224-232

ribbons
Excel 2007

Add-ins tab, 263
Data tab, 262
Developer tab, 263
Formulas tab, 262
Home tab, 262, 270-271
Insert tab, 262
Page Layout tab, 262
Review tab, 262
View tab, 262, 281

galleries, displaying, 17
menus, displaying, 16

questions



Series option (Fill button)
805

Picture Tools Format ribbon (Word 2007), 101
Brightness icon, 102
Change Picture icon, 105
Compress Pictures icon, 104-105
Contrast icon, 103
Crop icon, 110-111
Picture Border icon, 107-108
Picture Effects icon, 108-110
Picture Shapes icon, 107
Picture Styles icon, 106
Recolor icon, 103
Reset Picture icon, 105
Size icon, 111-113

tabs in, 16
Right (Indent) with the Indent Value Set to Zero option

(Excel Format Cells dialog, Alignment tab), 321

Right option (Fill button), 270

Rotate Text Down option (Excel Orientation menu), 320

Rotate Text Up option (Excel Orientation menu), 320

rotating
cell data (worksheets), 320
images in Word documents, 112-113

rotation effects (3D), adding to images in Word documents,
109

rows
Rows and Columns group (Table Tools Layout tab),

167
Word tables

inserting/deleting from, 167
sizing in, 168

worksheets
adding total rows to tables, 335
changing height, 313-314
deleting, 312-313
hiding, 326
inserting, 311

.rtf (rich text) file format, 38-39

Rules Manager dialog (Conditional Formatting dialog), 372

Rules menu (Word 2007), 201

S
Save As link (Microsoft Office Button), 15, 275

Save link (Microsoft Office Button), 15, 267

saving
Calendar (Outlook 2007) as iCalendar, 612
database table attachments, 682
documents, 37-39
PowerPoint presentations, 453-454
workbooks, 266, 429-431

scatter (XY) charts (Excel 2007), 387

scheduling
appointments (Outlook 2007), 605-608
meetings (Outlook 2007), 603-604

scope, Excel names, 330

searches
documents, 57
keyword searches, 57
Outlook 2007, 633

Instant Search feature, 634-635
search folders, 636-640

section breaks (continuous), 56

Section Header slide layout (PowerPoint 2007), 449

sections (documents), 50

security
data integrity

workbooks, 274-279
worksheets, 277-278

documents
controlling access in, 246-247
digital signatures, 250-251
editing, 251
marking as final, 251
password protection, 252

email
digital signatures, 572-573, 578
encryption, 579

Outlook 2007
digital signatures, 628
enabling/disabling add-ins, 623-624
enabling/disabling macros, 625-626
encryption, 626-627
Trusted Publishers list, 626

passwords, workbooks, 275-276
PowerPoint presentations, 509, 514
workbooks

data integrity, 274-279
locking cells, 276-277
worksheets, 277-278

worksheets, 277-278
Select Browse Object gallery (Word 2007), 217-219

selecting text in documents, 40-41

Send link (Microsoft Office Button), 15

send to back option (PowerPoint slides), 462

sending calendars (Outlook 2007) via email, 613

Sent To view (Outlook 2007), 544

sequencing questions (MCAS exams), 8-9

Series option (Fill button), 270-272
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Set Bookmark rule (Word Rules menu), 201

shading
text, Word document images, 120
Word tables, applying to, 166

shadow effects, adding to images in Word documents, 108

shapes, 96
autoshapes, inserting into Word documents, 97
email, adding to, 568
Excel charts, adding to, 397
free-form shapes, inserting into Word documents, 99
images in Word documents, adding to, 107
text, inserting into, 99

shared users, removing from workbooks, 428

sharing
Calendar (Outlook 2007), 613-614
documents

inspecting for hidden/private information, 243-245
managing metadata, 240-242

workbooks, 426-427
removing shared users, 428
removing sharing status, 428-429
resolving change conflicts, 428

shortcuts
keyboard shortcuts

mail merges, 202
multilevel lists, 139
selecting text, 41

Word 2007 documents, formatting, 80
Show Date Picker property (Access Design view), 666

Show properties (queries), 697

signatures (digital)
creating, 248-249, 572-573
email, 578, 628
Word documents, inserting in, 250-251

simulation questions (MCAS exams), 9

Size group (Picture Tools Format tab), 398-399

Size icon (Word Picture Tools Format ribbon), 111-113

sizing
forms (Access 2007), 708
images in Word documents, 111-112

skins (color schemes), changing in Word 2007, 59

Skip Record If rule (Word Rules menu), 201

slide shows (PowerPoint 2007), 445
configuring, 526-528
creating

basic slide shows, 522-523
hyperlinked slide shows, 524-525

setting default settings, 526

slides (PowerPoint 2007)
animations

applying custom animations to slides, 488, 491
applying standard animations to slides, 487-488
creating custom animations, 489-490
modifying custom animations, 492
options of, 487
removing custom animation effects, 492

Blank layout, 450
comments, 506

deleting, 508-509
editing, 508
inserting, 507
reviewing, 507

Comparison layout, 450
Content with Caption layout, 450
elements

aligning, 462-465
grouping, 462
ordering, 461-462

graphics, adding, 450
layouts, changing, 449-450
Picture with Caption layout, 450
printing

copies of slides, 517
setting default print settings, 515-516

Section Header layout, 449
slide masters

adding headers/footers to, 469-470
creating, 465-466
editing, 466-467
formatting, 469
setting backgrounds for, 467-469

Slide Sorter (PowerPoint 2007), 445, 448, 484
text, adding, 450
themes, applying, 450-452
Title and Content layout, 449
Title Only layout, 450
title slides, 449
transitions

adding sound to, 484-485
applying settings to all slides, 486
applying via Presentation pane, 482-483
applying via Slide Sorter, 484
changing speed of, 485
configuring advance slide setting, 486
removing, 486

Two Header layout, 449
Smart Tags property (Access Design view), 665

Set Bookmark rule (Word Rules menu)
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SmartArt graphics
all option, 95
creating, 95
email, adding to, 568
Excel charts, adding to, 397
object boxes (PowerPoint presentations), adding to,

458
Word documents, inserting into, 91, 95-96

soft edge effects, adding to images in Word documents, 109

soft page breaks, 48

sorting
Access 2007 data, 718

Advanced Filter, 722
alphanumeric values, 723
database tables, 723
date/time values, 723
hyperlink values, 723
numeric values, 723
queries, 723-726
yes/no values, 723

bulleted lists, 146
cell data in worksheets (Excel 2007), 403-404
numbered lists, 146
Sort button (Custom View: Documents dialog), 546
Sort properties (queries), 696
Word table data, 169-170

sound, PowerPoint transitions, 484-485

Source Manager (Word 2007), 188-189

spacing, changing in lists, 145

Split Form tool (Access 2007), 701

splitting
cells, Word tables, 168
databases (Access 2007), 683
Word tables, 168
worksheets, 284-285

spreadsheets (Excel 2007), inserting objects into Word
documents, 158

SQL statements, viewing in Access 2007 queries, 699-700

stationery (email), 556-557

status bar, customizing, 19

stock charts (Excel 2007), 387

Stripes and Bars option (PowerPoint transitions), 483

Structure option (Protect Structure and Windows dialog),
279

study guides, 10

study resources (MCAS exams), 10-11

styles (Word 2007)
applying, 72

character styles, 70
linked styles, 70
list styles, 70
new styles, creating, 71-72
paragraph styles, 70
Quick Styles, 73
Style task pane, 70
table styles, 70-71
viewing, 68

Subtotal feature, summarizing data via, 354-357

subtotals (Excel 2007), inserting into outlines, 400-401

SUMIF function
conditional counts/averages, 354
conditional logic in Excel formulas, 361
summarizing data via, 352-353

summarizing data, Excel formulas
conditional counts/averages, 354
summarizing data via

Subtotal feature, 354-357
SUMIF function, 352-353
SUMIFS function, 353

surface charts (Excel 2007), 387

switching between workbooks, 286

symbols, adding to email, 563

Synchronous Scrolling option (worksheets), 285

T
tables

database tables
attaching documents to, 679-681
AutoNumber primary keys, 672
changing primary keys, 673
defining relationships, 668
deleting relationships, 670-671
editing attached files, 681
exporting to Excel, 765
exporting to Word, 766-767
finding/replacing data, 677-678
importing data into, 674-676
Linked Table Manager (Access 2007), 756
linking, 751-752
linking to Excel worksheets, 755
linking to ODBC tables, 752, 754
manually entering data, 674
many-to-many relationships, 667
one-to-many relationships, 667
one-to-one relationships, 666
primary keys, 671-672
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printing relationships, 670
removing attached files, 682
removing primary keys, 673
saving attached files, 682
setting primary keys, 672
sorting, 723

databases
creating in via Datasheet view (Access 2007), 

657-659
creating in via Design view (Access 2007), 659-660
modifying field properties via Design view (Access

2007), 660-666
email, adding to

Quick Tables, 560-561
Table Grid feature, 562

names (Excel cells), 328
object boxes (PowerPoint presentations), adding to,

456
ODBC tables, linking to database tables, 752-754
Table Grid feature, adding tables to email, 562
Table view (Create a New View dialog), 547
Word 2007, 156

formatting, 164-173
inserting into Word documents, 156-163
sorting data, 169-170
table styles, 70-71
Table Tools Design tab, 164-166
Table Tools Layout tab, 166-169

worksheets
adding total rows to tables, 335
converting tables to cell ranges, 334
creating, 333
formatting table data, 334
setting design options, 335

tables of contents, 182, 185-186

tabs
application ribbons, 16
worksheets, changing tab color in, 301

tasks (Outlook 2007), 608-610

templates
Access databases, 654-655
document templates

applying via Microsoft Office Online, 33-35
Blank and Recent option (New Document dialog,

Templates section), 31
choosing, 31-33
Installed Templates option (New Document dialog,

Templates section), 32
My Templates option (New Document dialog,

Templates section), 32

New from Existing option (New Document dialog,
Templates section), 33

email messages, 576
PowerPoint presentations

applying to, 452-453
creating new templates, 471

Templates section (New Document dialog), 31-33
Word 2007, 135
workbooks, creating, 266

tests
MCAS tests, 8-9
practice tests, 8-9
pretests, purchasing vouchers for, 7
study resources, 10-11
test preparation strategies, 7
test-taking strategies, 12

text
AutoFill feature, 267-269
centering, 321
converting in Word tables, 169
documents

copying in, 43
cutting/pasting in, 43
deleting from, 41
entering in, 35-36
finding/replacing in, 42-43
replacing in, 41-43
selecting in, 40-41

Excel 2007
changing styles in charts, 396
formatting via formulas, 364-365

fonts
changing in email, 558
changing in worksheet cells, 308-310
configuring in workbooks, 265

indenting, 321
Rotate Text Down option (Excel Orientation menu),

320
Rotate Text Up option (Excel Orientation menu), 320
shapes, inserting into, 99
slides (PowerPoint 2007), adding to, 450
Text Align property (Access Design view), 666
text boxes, Word document images, 120
text data types (Access queries), 697-698
Vertical Text option (Excel Orientation menu), 320
Word document images

applying shading to text, 120
highlighting text via borders, 118-119
inserting/formatting text in text boxes, 120

tables
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Word tables, aligning in, 168
word wrap feature, cell data (worksheets), 319
wrapping text around images, Word documents, 

116-117
text boxes, PowerPoint presentations

adding to, 455
formatting text in, 456

Text Format property (Access Design view), 666

textures
email backgrounds, 567
slide master backgrounds (PowerPoint presentations),

468
Themed Cell Styles section (Cell Styles gallery), 317

themes
email, 564
slides (PowerPoint 2007), applying to, 450
Microsoft Office Online, 451-452
Theme Gallery, 451
Word 2007 themes, 74-75
worksheets, applying to, 327-328

Thumbnails view (Word 2007), 216-217

time/date
date/time data types (Access queries), 698-699
date/time values, sorting data by (Access 2007), 723

Timeline view (Create a New View dialog), 547

timing slides (PowerPoint presentations), 486

Title and Content slide layout (PowerPoint 2007), 449

Title Only slide layout (PowerPoint 2007), 450

title slides (PowerPoint 2007), 449

Titles and Headings section (Cell Styles gallery), 317

ToC (table of contents)
content, updating, 186
formatting, 185
page numbers, updating, 186
references, adding, 185
Word documents, 182, 186

toolbars. See also ribbons
mini toolbar, 18
Quick Access Toolbar, 17
status bar, customizing, 19

Top/Bottom Rules option (Conditional Formatting dialog),
368

Total Row option (Table Tools Design tab), 164

total rows (Excel), adding to tables, 335

Track Changes feature (Word 2007), 224-225

tracking
balloons, 225-226

changes
Word documents, 224-232
workbooks, 418-421

email
delivery receipts, 581-582
flags, 580-581
request reads, 581-582

training courses, 11

transitions (PowerPoint slides). See also animations
(PowerPoint slides)

advance slide setting, configuring, 486
applying

Presentation pane (PowerPoint 2007), 482-483
settings to all slides, 486
Slide Sorter (PowerPoint 2007), 484

removing from slides, 486
sound, adding to, 484-485
speed of, changing, 485

Trust Center (Outlook 2007)
digital signatures, 628
email encryption, 627
enabling/disabling

add-ins, 623-624
macros, 625-626

Trusted Publishers list, 626
Two Header slide layout (PowerPoint 2007), 449

Two Pages per Sheet option (documents), 50

.txt (plain text) file format, 39

U
Unfreeze Panes option (Freeze Panes menu), 284

Unicode Compression property (Access Design view), 665

Unread Messages in This Folder view (Outlook 2007), 544

user interface, 14
application ribbons

displaying galleries, 17
displaying menus, 16
tabs in, 16

key tips, 18-19
Microsoft Office Button

Close link, 15, 21
Excel Options button, 263-265, 273
Exit button, 16, 21
New link, 15, 264-266
Open link, 15, 20
Options button, 16
Prepare link, 15
Print link, 15, 22
Publish link, 15
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Save As link, 15, 275
Save link, 15, 267
Send link, 15

mini toolbar, 18
Quick Access Toolbar, 17
status bar, customizing, 19

users
permissions, restricting in Word documents, 247
shared users, removing from workbooks, 428

V
Validation Rule property (Access Design view), 664

Validation Text property (Access Design view), 665

vertical data lookups (Excel 2007), 362-363

Vertical Text option (Excel Orientation menu), 320

vertically aligning cell data (worksheets), 318

video, adding to object boxes (PowerPoint presentations),
460

View Saved in the File option (PowerPoint default view),
The, 446

View Side by Side option (worksheets), 285

View tab (Excel ribbon), 262, 281

viewing
galleries, application ribbons, 17
menus, application ribbons, 16
workbooks

configuring default views, 265
switching between workbooks, 286

worksheets
changing views, 279-281
custom views, 286
Freeze Panes menu, 284
Full Screen view, 280
Multiple Windows view, 282-283
multiple worksheets, 285
Normal view, 280
Page Break Preview view, 280
Page Layout view, 280
Reset Window Position option, 285
Split option, 284-285
Synchronous Scrolling option, 285
View Side by Side option, 285

VLOOKUP (vertical lookup) function, 362-363

vouchers (pretests), purchasing, 7

W
watermarks, Word documents, 76-79

weeks (days of), entering into workbooks via AutoFill
feature, 268-269

widows/orphans (line/page breaks), 51-52

width, changing in worksheet columns, 313-314

wildcards, filtering Excel data via, 407

Windows Clipboard, 44

Windows option (Protect Structure and Windows dialog),
279

Wipes option (PowerPoint transitions), 483, 487

wizards
Form Wizard (Access 2007), 703, 705
Report Wizard (Access 2007), creating reports via, 

727-730
Word 2007

Access database tables, exporting to, 766-767
building blocks

changing, 136
creating, 133-134
inserting into Word documents, 134
removing, 137
renaming, 136
saving in templates, 135

customizing, 58
documents

adding links to, 121-122
attaching to database tables, 679-682
bibliographies, 191
captioning images in, 114-115
comments, 227-231
comparing, 220-222
compatibility checks, 253
controlling access to, 246-247
controlling embedded links, 162-163
digital signatures, 250-251
Document Inspector, 243-245
editing, 251
editing images in, 110-113
encrypting, 246
endnotes, 187
footnotes, 186-187
formatting, 68-80
formatting images in, 101-110, 118-120
initializing, 58
inserting building blocks into, 134
inserting embedded links into, 161
inserting Excel data into, 161

user interface
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inserting images into, 90-100
inserting links into, 160
inserting tables into, 156-163
marking as final, 251
merging, 192-203, 222-223
navigating, 216
navigating via Select Browse Object features, 

217-219
navigating via Thumbnails view, 216-217
password protection, 252
references, 182, 185, 188-191
reviewing, 220-232
sharing, 240-245
sorting data, 169-170
tables of contents, 182, 185-186
tracking changes, 224-232
wrapping text around images, 116-117

envelopes
printing merged envelopes, 204
printing single envelopes, 203-204

Home tab, formatting documents, 79-80
labels, printing, 205-207
languages, changing, 59
lists

bulleted lists, 137-141, 145-146
multilevel lists, 138-139
numbered lists, 137-146

Mail Merge feature, 769-770
Mailings tab, 192-203
personalizing, 58
Picture Tools Format ribbon, 101

Brightness icon, 102
Change Picture icon, 105
Compress Pictures icon, 104-105
Contrast icon, 103
Crop icon, 110-111
Picture Border icon, 107-108
Picture Effects icon, 108-110
Picture Shapes icon, 107
Picture Styles icon, 106
Recolor icon, 103
Reset Picture icon, 105
Size icon, 111-113

Quick Parts feature, 132
changing building blocks, 136
creating building blocks, 133-134
inserting building blocks into Word documents, 134
removing building blocks, 137
renaming building blocks, 136
saving building blocks in templates, 135

Quick Tables, inserting into Word documents, 158
Rules menu, 201
Select Browse Object gallery, 217-219
shortcut menu, formatting documents, 80
Source Manager, adding references to, 188-189
styles

applying styles, 72
character styles, 70
creating new styles, 71-72
linked styles, 70
list styles, 70
paragraph styles, 70
Quick Styles, 73
table styles, 70-71
viewing, 68-70

tables
formatting, 164-171
formulas in, 172-173
inserting into documents, 156-163
sorting data in, 169-170

templates, saving building blocks in, 135
themes, 74-75
Thumbnails view, 216-217
Track Changes feature, 224-225
watermarks, 76-79

word wrap feature, cell data (worksheets), 319

workbooks
access, limiting, 428-429
cells, locking, 276-277
configuring, 265
creating, 264-266
data integrity, 274, 279

encryption, 275-276
locking cells, 276-277
passwords, 275-276
worksheets, 277-278

days of the week, entering into via AutoFill feature,
268-269

distributing, 429
editing cell ranges, 421-422
encryption, 275-276
memory and, 265
months of the year, entering into via AutoFill feature,

269
numerical data series, entering into via AutoFill

feature, 269
passwords, 275-276
printing, 434
protecting, 423
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saving, 266, 429-431
switching between, 286
tracking changes in, 418-421
worksheets

adding to workbooks, 299
changing number of worksheets in workbooks, 300
data integrity in, 277-278
deleting from workbooks, 303
moving in workbooks, 301

worksheets
Across Worksheets option (Fill button), 270-271
backgrounds, changing, 303-304
cells

adding borders, 315-316
adding color, 324
adding data bars to, 368
adding gradient color scales to cell ranges, 369
adding icons to, 369
aligning data, 317-318, 321-322
applying styles to, 316-317
centering aligned data, 318
changing fonts, 308-310
changing orientation (rotation), 320
converting tables to, 334
defined names, 328-332
deleting, 312-313
fitting data to cell size, 323-324
formatting via Excel formulas, 365-369
grouping data for outlines, 399
hiding data, 325
highlighting, 366-368
indenting data, 318
inserting, 310-311
inserting subtotals into cell ranges, 355
inserting subtotals into outlines automatically, 

400-401
inserting subtotals into outlines manually, 400
merging, 324-325
merging aligned data, 318
name scope, 330
table names, 328
wrapping data, 319

columns
changing width, 313-314
deleting, 312-313
hiding, 326
inserting, 311-312

copying, 302
data integrity, 277-278

database tables
exporting data to, 674-675
linking to, 755

embedded links, inserting into Word documents, 
161-163

filtering data
AutoFilter function, 405-406
custom filters, 406-407
wildcards, 407

formatting, 304
gridlines, changing color of, 324
multiple worksheets, controlling, 285
page numbers

changing, 307
changing sequence of, 307
inserting into multiple worksheets, 306
inserting into single worksheets, 305

printing, 433-434
protecting, 424-425
renaming, 300
rows

changing height, 313-314
deleting, 312-313
hiding, 326
inserting, 311

sharing, 426-429
sorting data, 403-404
tables

adding total rows to, 335
converting to cell ranges, 334
creating, 333
formatting data, 334
setting design options, 335

tabs, changing color of, 301
themes

custom themes, 328
predefined themes, 327

views
changing, 279-281
custom views, 286
Freeze Panes menu, 284
Full Screen view, 280
Multiple Windows view, 282-283
multiple worksheets, 285
Normal view, 280
Page Break Preview view, 280
Page Layout view, 280
Reset Window Position option, 285
Split option, 284-285

workbooks



Zoom to Selection option (Excel 2007 ribbon, View tab)
813

Synchronous Scrolling option, 285
View Side by Side option, 285

workbooks
adding worksheets to, 299
changing number of worksheets in, 300
configuring default number of worksheets in, 265
deleting worksheets from, 303
moving worksheets in, 301

workspace
closing, 21
workspace view (PowerPoint 2007), changing, 445

wrapping text
cell data (worksheets), 319
images in Word documents, 116-117

X - Y - Z
xls file extension, 429

XML (Extensible Markup Language)
Access database objects, exporting XML files to, 768
Custom XML Data category (Document Inspector),

511

years (months of), entering into workbooks via AutoFill
feature, 269

yes/no values, sorting data by (Access 2007), 723

zoom feature, changing worksheet views via, 280-281

Zoom to Selection option (Excel 2007 ribbon, View tab), 281
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